Installing and Configuring vCloud Connector

vCloud Connector 2.0.0

This document supports the version of each product listed and supports all subsequent versions until the document is replaced by a new edition. To check for more recent editions of this document, see http://www.vmware.com/support/pubs.
You can find the most up-to-date technical documentation on the VMware Web site at:
http://www.vmware.com/support/
The VMware Web site also provides the latest product updates.
If you have comments about this documentation, submit your feedback to:
docfeedback@vmware.com
Contents

Installing and Configuring vCloud Connector  5

1 vCloud Connector Editions  7

2 vCloud Connector Overview  9
   vCloud Connector  9

3 Planning Your vCloud Connector Installation  11
   Deploying Multi-tenant Nodes as a vCloud Service Provider  11

4 Installing vCloud Connector  15
   Collect Necessary Information  16
   Check System Requirements  18
   Download the vCloud Connector Virtual Appliances  19
   Install vCloud Connector Server  20
   Configure vCloud Connector Server  27
   Install vCloud Connector Nodes  30
   Register vCloud Connector Nodes with Clouds  38
   Configure vCloud Connector Nodes  39
   Register vCloud Connector Nodes with vCloud Connector Server  42
   Register the vCloud Connector UI  43
   Prepare vCloud Connector for Production Use  45

5 Entering the License Key for vCloud Connector Advanced Edition  53

6 Upgrading to vCloud Connector 2.0  55
   Upgrade to vCloud Connector 2.0 from the Admin Web Consoles  55
   Edit Hardware Settings for Upgraded vCloud Connector Server and Nodes on vSphere  56
   Edit Hardware Settings for Upgraded vCloud Connector Server and Nodes on vCloud Director  57
   Update Registration with vSphere Client  57

7 Cross-Cloud Data Transfer and Network Connectivity  59

8 Uninstalling vCloud Connector  61
   Uninstall a vCloud Connector Server  61
   Uninstall vCloud Connector Nodes  62

9 Troubleshooting vCloud Connector  65
   Troubleshooting Storage  65
   Troubleshooting Connectivity  66
Accessing Log Files from the UI 66
Accessing Log Files from the Console 67
Accessing Log Files for a Multi-tenant Node 68
Troubleshooting Log File Size 68

Index 71
Installing and Configuring vCloud Connector

*Installing and Configuring vCloud Connector* provides a brief overview of VMware vCloud® Connector™. It also provides detailed information on installing and configuring vCloud Connector Server and vCloud Connector Nodes and setting up the vCloud Connector UI.

**Intended Audience**

This information is intended for anyone who wants to set up vCloud Connector (vCC). You should be familiar with vSphere Client, the vCloud Director Web console, and deploying virtual appliances.
vCloud Connector 2.0 has two editions: vCloud Connector 2.0 Core and vCloud Connector 2.0 Advanced.

vCloud Connector 2.0 Advanced requires a valid vCloud Suite 5.1 license key to enable its features. In addition to vCloud Connector 2.0 Core features, it includes the following advanced features:

- Content Sync
- Stretch Deploy (also referred to as Datacenter Extension)

See Chapter 5, “Entering the License Key for vCloud Connector Advanced Edition,” on page 53 for information on how to assign the license key.
This section provides an overview of vCloud Connector. It describes the functionality of vCloud Connector and the components that make it up.

**vCloud Connector**

vCloud Connector is an enterprise product that provides a single user interface for overseeing multiple public and private clouds and for transferring cloud content from one cloud to another. It allows you to connect multiple clouds, both internal and external, in a single user interface.

Using vCloud Connector, you can stop and start virtual machines, check their performance, and transfer virtual machines, vApps, and templates from one cloud to another.

Using vCloud Connector Advanced edition, you can also extend your private datacenter to a public vCloud and set up a Content Library to distribute and synchronize templates across clouds.

**vCloud Connector Components**

vCloud Connector consists of three distinct components: the vCloud Connector UI, the vCloud Connector Server, and vCloud Connector Nodes.
vCloud Connector UI

vCloud Connector UI is the user interface that vCloud Connector Server produces. It can be surfaced in vSphere Client. You decide where to display the UI during the configuration process.

vCloud Connector Server

vCloud Connector Server is a virtual appliance that coordinates the activity of vCloud Connector, controls vCloud Connector Nodes, and produces the vCloud Connector UI. Only one vCloud Connector Server is needed.

vCloud Connector Nodes

vCloud Connector Nodes are virtual appliances that handle transferring content from one cloud to another. Transfers between clouds that are interrupted, for example because of network problems, can be resumed at the point that they were interrupted. A vCloud Connector Node must be installed in every vSphere or vCloud Director cloud that vCloud Connector oversees.
Planning Your vCloud Connector Installation

Before you install vCloud Connector, you need to do some basic high-level planning.

You need to decide the following.

- Where you want to install the vCloud Connector Server
- Which clouds you want to be able to add to the vCloud Connector UI. You must install a vCloud Connector Node in each cloud that you want to add.
  
  On vCloud Director clouds, you do not need to install a Node for each organization. vCloud Connector Nodes are multi-tenant, that is, one Node can be used by multiple organizations to transfer content to and from the cloud. If you are a public vCloud service provider or the system administrator of a private vCloud Director cloud that has many organizations, you can choose to install one Node in the cloud for multiple organizations to use.

- In which vSphere Client you want to surface the UI

You also need to collect specific information to use during the installation and configuration process. What you need to know depends on your specific installation decisions. A detailed description of the information you should collect is covered in “Collect Necessary Information,” on page 16.

Deploying Multi-tenant Nodes as a vCloud Service Provider
vCloud Connector Nodes are multi-tenant, that is, one Node can be used by multiple tenants to transfer content to and from a cloud.

As a public vCloud Service Provider (or the administrator of a private vCloud Director cloud serving many departments), you can deploy a multi-tenant Node in the cloud for your customers to use, instead of requiring each customer to install a Node in their own organization in the cloud.

Each Node can support 20 tenants. Depending on the number of tenants, you might need to deploy multiple vCloud Connector Nodes.

For example, you might deploy the following Nodes:

- Multi-tenant Node A for customers 1-20 on public vCloud 1
- Multi-tenant Node B for customers 21-40 on public vCloud 1
- Multi-tenant Node C for customers 41-60 on public vCloud 2
- Multi-tenant Node D for customers 61-80 on public vCloud 2

After you deploy the Nodes, you would provide the appropriate Node URL to each set of customers for them to register the Node with their own vCloud Connector Servers.

**Deployment Considerations**

- As each multi-tenant Node is dedicated to a group of customers, vCloud Connector does not support using a Load Balancer in front of a multi-tenant Node.
- Each multi-tenant Node can support up to 20 organizations.
Deploying Multi-tenant Nodes

1. Determine how many multi-tenant Nodes you need based on the number of customers you intend to support.
   Each Node can support 20 organizations.

2. Install vCloud Connector Nodes in the public vCloud, one for each set of customers.
   See Chapter 4, “Installing vCloud Connector,” on page 15 for more information.

3. Email the appropriate Node URL to each set of customers. Specify either the IP address of the Node or its fully qualified domain name (FQDN):
   - \textit{https://<vCCNode\_IPaddress>}
     For example: \textit{https://10.10.100.10}
   - \textit{https://<Fully\_Qualified\_Domain\_Name\_of\_vCCNode>}
     For example: \textit{https://node1.company.com}

4. Ask the customers to register the Node with their vCloud Connector Servers using the Node URL you provided and their own organization credentials.
   See “Register vCloud Connector Nodes with vCloud Connector Server,” on page 42.
   Each customer will register the multi-tenant Node with their own vCloud Connector Server, using the URL you provided and their own organization credentials. This enables them to transfer content to and from their organization in the public vCloud.

Accessing Node Log Files

As the multi-tenant Node administrator, you can access Node log files for all customers from the Node console or Admin Web console. Log files are divided by organization. See “Accessing Log Files from the Console,” on page 67 and “Accessing Log Files from the UI,” on page 66.

Customers do not have access to the multi-tenant Node console or Web console. They can access Node log files from their vCloud Connector Server Admin Web console. See “Accessing Log Files for a Multi-tenant Node,” on page 68 for more information.
Installing vCloud Connector is a multi-step process. This section gives you a high-level overview of the steps you need to take.

**Figure 4-1. vCloud Connector Installation and Configuration Workflow**

This figure illustrates all the combinations that you can use with vCloud Connector. Typically, you would use a subset of these.

Common installation scenarios include using vCloud Connector to
- Connect a private vSphere cloud with a public vCloud.
- Connect a private vCloud Director cloud with a public vCloud.
- Connect a private vSphere cloud with a private vSphere cloud.
- Connect a private vCloud Director cloud with a private vCloud Director cloud.

You install a vCloud Connector Node in each cloud that you want to connect. You only need one vCloud Connector Server.
**Procedure**

1. **Collect Necessary Information** on page 16
   Print this worksheet section to help you collect the information you need to install and configure vCloud Connector.

2. **Check System Requirements** on page 18
   You must ensure that your system meets the minimum requirements before you install vCloud Connector.

3. **Download the vCloud Connector Virtual Appliances** on page 19
   vCloud Connector Server and vCloud Connector Nodes are packaged as virtual appliances. You download the virtual appliances from the vCloud Connector Download page.

4. **Install vCloud Connector Server** on page 20
   You can install vCloud Connector Server in a vSphere cloud or in a vCloud Director cloud.

5. **Configure vCloud Connector Server** on page 27
   You use the vCloud Connector Server Admin Web console to do basic configuration tasks, such as defining your time zone, specifying proxy servers, or setting log levels. What you need to do depends on your particular installation.

6. **Install vCloud Connector Nodes** on page 30
   You can install vCloud Connector Nodes in vSphere or vCloud Director clouds.

7. **Register vCloud Connector Nodes with Clouds** on page 38
   After you install a vCloud Connector Node for a cloud, you need to register it with the cloud.

8. **Configure vCloud Connector Nodes** on page 39
   You use the vCloud Connector Node Admin Web console for each of your Nodes to do basic configuration tasks, such as defining your time zone, specifying proxy servers, or setting log levels. What you need to do depends on your particular installation.

9. **Register vCloud Connector Nodes with vCloud Connector Server** on page 42
   You use the vCloud Connector Server Admin Web console to register vCloud Connector Nodes with the vCloud Connector Server. The Nodes are installed on vSphere, private vCloud Director clouds, or public vClouds. The registration allows the Server to manage the Nodes.

10. **Register the vCloud Connector UI** on page 43
    To surface the vCloud Connector UI, you register it to a vSphere Client.

11. **Prepare vCloud Connector for Production Use** on page 45
    Before you place vCloud Connector into production use, you must prepare it for a full production environment.

**Collect Necessary Information**

Print this worksheet section to help you collect the information you need to install and configure vCloud Connector.

**Accounts**

You need the following accounts.
Table 4-1. Account Information

<table>
<thead>
<tr>
<th>Account Type</th>
<th>Information Needed</th>
<th>Used For</th>
</tr>
</thead>
<tbody>
<tr>
<td>One of the following: ■ vCenter Server administrator account ■ vCloud Director account with at least Org Administrator status</td>
<td>Username, password and URL or IP address for the appropriate entity</td>
<td>Installing vCloud Connector Server</td>
</tr>
<tr>
<td>vCenter Server administrator account for each vSphere cloud</td>
<td>Username, password and URL or IP address</td>
<td>Installing vCloud Connector Node</td>
</tr>
<tr>
<td>vCloud Director account with at least Org Administrator status for each vCloud Director cloud</td>
<td>Username, password and URL or IP address</td>
<td>Installing vCloud Connector Node</td>
</tr>
</tbody>
</table>

Proxy Servers

You need the following proxy information.

Table 4-2. Proxy Information

<table>
<thead>
<tr>
<th>Install Type</th>
<th>Information Needed</th>
<th>Condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>vCloud Connector Server</td>
<td>host:port</td>
<td>If the Server needs a proxy to be able to access systems beyond the firewall in the location in which it is installed.</td>
</tr>
<tr>
<td>vCloud Connector Node - per Node</td>
<td>host:port</td>
<td>If the Node needs a proxy to be able to access systems beyond the firewall in the location in which it is installed.</td>
</tr>
</tbody>
</table>

Network

If you are using a static IP (not using DHCP) for vCloud Connector Server or vCloud Connector Node, you need the following information for each instance.

Table 4-3. Network Information

Network Information

An available static IP address
The netmask for that address
The IP address of the gateway
The IP address of a primary and secondary DNS server
A hostname (optional)

For more information on network paths in data transfers, see Chapter 7, “Cross-Cloud Data Transfer and Network Connectivity,” on page 59.
Displaying the vCloud Connector UI

To set up the vCloud Connector UI to display in a vSphere Client, you need the following information.

**Table 4-4. vCloud Connector UI in vSphere**

<table>
<thead>
<tr>
<th>vCloud Connector UI in vSphere</th>
</tr>
</thead>
<tbody>
<tr>
<td>The IP address or fully qualified domain name of the vCenter</td>
</tr>
<tr>
<td>Server to which you will be connecting.</td>
</tr>
<tr>
<td>A username and password for the vCenter Server.</td>
</tr>
<tr>
<td>The IP address or fully qualified domain name of the deployed</td>
</tr>
<tr>
<td>vCloud Connector Server. This information is assigned when the</td>
</tr>
<tr>
<td>vCloud Connector Server is first deployed.</td>
</tr>
</tbody>
</table>

Check System Requirements

You must ensure that your system meets the minimum requirements before you install vCloud Connector.

Hardware and Software Requirements

To deploy and configure vCloud Connector Server and Nodes, you need the following:

**Table 4-5. VMware Products**

<table>
<thead>
<tr>
<th>Product</th>
<th>Supported Version</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>vSphere</td>
<td>4.0, 4.1, 5.0, 5.1</td>
<td>If you are deploying the vCC Server or vCC Nodes on vSphere</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> To use the Stretch Deploy feature (Datacenter Extension), you must install vSphere 5.1.</td>
</tr>
<tr>
<td>vCloud Director</td>
<td>1.5, 5.1</td>
<td>If you are deploying the vCC Server or vCC Nodes on vCloud Director</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> To use the Stretch Deploy feature (Datacenter Extension), you must install vCloud Director 5.1.</td>
</tr>
<tr>
<td>vShield Manager</td>
<td>5.1.2</td>
<td>Required for the Stretch Deploy feature (Datacenter Extension) only.</td>
</tr>
</tbody>
</table>

**Note** The Stretch Deploy feature has special system requirements. See System Requirements for Stretch Deploy in Using vCloud Connector for more information.

**Note** If you are deploying on vSphere, you also need a Microsoft Windows desktop with vSphere Client installed.

To access the vCloud Connector Server and Node Web Admin consoles, you need a browser.

**Table 4-6. Supported Browsers**

<table>
<thead>
<tr>
<th>Browser</th>
<th>Supported Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Internet Explorer</td>
<td>8, 9</td>
</tr>
<tr>
<td>Firefox</td>
<td>15, 16</td>
</tr>
<tr>
<td>Chrome</td>
<td>22, 23</td>
</tr>
</tbody>
</table>
The browser must be set to accept third-party cookies.

**NOTE** Do not use Firefox to log on to the vCloud Connector Server and Node Admin Web consoles. Some tabs (such as the Server tab in the Server Admin Web console and the Node tab in the Node Admin Web console) display blank pages on Firefox.

### Required Ports

vCloud Connector uses the following ports to communicate between its various components: Server, Nodes, and the Server and Node Admin Web consoles.

**Table 4-7. Port Information**

<table>
<thead>
<tr>
<th>Port Number</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>443</td>
<td>Used when SSL is enabled. This port is used for communication between the vCC Server and vCC Nodes and between Nodes.</td>
</tr>
<tr>
<td>80</td>
<td>Used when SSL is disabled. This port is used for communication between the vCC Server and vCC Nodes and between Nodes.</td>
</tr>
<tr>
<td>5480</td>
<td>This port is used for communication with the vCC Server and Node Admin Web Consoles.</td>
</tr>
</tbody>
</table>

**NOTE** Ports 8080 and 8443 are used for the Local Content Directory Node, which is a node that is automatically installed with the vCloud Connector Server and which is used for the Content Library. Port 8080 is used when SSL is disabled and port 8443 is used when SSL is enabled.

### Download the vCloud Connector Virtual Appliances

vCloud Connector Server and vCloud Connector Nodes are packaged as virtual appliances. You download the virtual appliances from the vCloud Connector Download page.

**Prerequisites**

You have collected the information specified in “Collect Necessary Information,” on page 16.

**Procedure**

1. Go to the vCloud Connector Download page.
2. Click **Download**.
3. Scroll down to the **Product Downloads** section and download both the \texttt{vCCServer} and \texttt{vCCNode} files.
   a. Click either **Download Manager** or **Manually Download**. For information about each method, click the **Need help downloading?** link at the top of the section.
   b. Log on with your My VMware account information.
   c. Read and accept the End User License Agreement.
      A dialog box appears that prompts you to open or save the zip file.
   d. Download the zip file to your desktop.
Install vCloud Connector Server

You can install vCloud Connector Server in a vSphere cloud or in a vCloud Director cloud.

Only one vCloud Connector Server is required for each vCloud Connector installation. Choose one of the following options to install your Server.

Install vCloud Connector Server in vSphere

You can install vCloud Connector Server in vSphere 4.0, 4.1, 5.0, or 5.1.

Prerequisites

You must have an administrator account on the vSphere in which you deploy the vCloud Connector Server. You must have the unzipped version of the template you downloaded in “Download the vCloud Connector Virtual Appliances,” on page 19.

Procedure

1. Log on to vSphere Client.
2. Select File > Deploy OVF template.
3. Click Browse to navigate to the OVF directory of the Server zip file.
4. Click Next.
5. Proceed through the wizard.
   
   You can either use the Networking Properties step in the wizard to set basic network properties or you can wait and set those properties when you configure your server.

   **NOTE** If you are going to use a static IP address, you need to assign it here. Proxy information is set during “Configure vCloud Connector Server,” on page 27

6. In the vSphere Client, select Inventory > VMs and Templates to see the created virtual machine in the tree.
7. Right-click the virtual machine and select Power > Power on to power on the machine.
8. Click the Summary tab and find the vCloud Connector Server’s IP address in the General section. The IP address field (not the Host field) displays the IP address of the vCloud Connector Server. Make a note of the IP address. You will need it later in the process.

Install vCloud Connector Server in vCloud Director 1.5

You can install vCloud Connector Server in vCloud Director 1.5.

**NOTE** If you install vCloud Connector Server in a public cloud, you can only connect to public clouds in your vCloud Connector UI.

Prerequisites

You must have at least Organization Administrator access in the vCloud Director on which you install the vCloud Connector Server.
Procedure

1 **Add vCloud Connector Server to a vCloud Director 1.5 Catalog as a vApp Template** on page 21
   Before you can deploy a vCloud Connector Server in a vCloud Director 1.5 cloud, you must upload the virtual appliance to a catalog as a vApp template. You do not need to upload an additional template if a template is already uploaded to a master catalog that multiple organizations share.

2 **Create the vCloud Connector Server from the Template in a vCloud Director 1.5 Cloud** on page 21
   After the vCloud Connector Server is added to the vCloud Director 1.5 cloud as a template, you can use it to create a running instance on that cloud.

3 **Set Up NAT Mapping for vCloud Connector Server in vCloud Director 1.5** on page 22
   If you select a NAT-based network connection when you deploy your vCloud Connector Server, you need to set up NAT mapping and firewall rules.

### Add vCloud Connector Server to a vCloud Director 1.5 Catalog as a vApp Template

Before you can deploy a vCloud Connector Server in a vCloud Director 1.5 cloud, you must upload the virtual appliance to a catalog as a vApp template. You do not need to upload an additional template if a template is already uploaded to a master catalog that multiple organizations share.

**Prerequisites**

You must have System Administrator or Organization Administrator access on the vCloud Director cloud on which you install the vCloud Connector Server. You must have the unzipped version of the template you downloaded in “Download the vCloud Connector Virtual Appliances,” on page 19.

**Procedure**

1 Log on to the vCloud Director Web console using a supported browser.
2 Click **Catalogs**.
   If you log on as System Administrator, select your organization first, then click the **Catalogs** tab.
3 Double-click the catalog to which you want to upload the vCloud Connector Server, then click the **vApp Templates** tab.
4 Click the **Upload** icon.
5 In the Upload OVF package as a vApp Template dialog box, click **Browse**, accept the security certificate if you are prompted to do so, and select the vCloud Connector Server OVF file that you downloaded.
6 Specify a name and, optionally, a description, for the vApp template.
7 Select the virtual datacenter and catalog for the template.
8 Click **Upload**.

The upload process begins. You can monitor the status of the upload in the **Transfer Progress** popup.

**Note** It may take several seconds after the upload itself has finished for the process to finalize in the cloud.

### Create the vCloud Connector Server from the Template in a vCloud Director 1.5 Cloud

After the vCloud Connector Server is added to the vCloud Director 1.5 cloud as a template, you can use it to create a running instance on that cloud.

**Prerequisites**

You must have at least Organization Administrator access on the vCloud Director cloud on which you install the vCloud Connector Server.
Procedure

1. On the vApp Templates tab of the catalog to which you uploaded, right-click the name of your vCloud Connector Server template and select Add to My Cloud.
   
   The Add to My Cloud popup appears.

2. Give the Server vApp an easily identifiable name and provide a description.

3. Set the leases for the Server vApp and click Next.

4. Read and accept the EULA, and click Next.

5. Select an appropriate network from the Network drop-down menu.
   
   Unless all your vCloud Connector Nodes and the vCloud Connector Server are behind the same firewall, you must select a network that is configured to access the Internet. Ask your service provider or network administrator for more information.

   **Note**: If your provider uses NAT, you will need to set up NAT mapping after your Server is deployed. See “Set Up NAT Mapping for vCloud Connector Server in vCloud Director 1.5,” on page 22.

6. Select the appropriate IP Assignment from the drop-down menu and click Next.
   
   If there is a static IP pool, that is probably a reasonable choice. Ask your Service Provider or Network Administrator for more information.

7. In the Networking Properties page, use the information you collected before you began installing vCloud Connector to specify the DNS server, IP address, Netmask, and Default Gateway. If you are using DHCP, leave the fields blank.

8. In the Configure Networking page, leave both check boxes unselected, and click Next.

9. In the Ready to Complete page, review the settings and click Finish.

10. Click the My Cloud tab, then select vApps in the My Cloud panel.
   
   You see the vApp being created.

11. In the My Cloud panel, select VMs, right-click your vCloud Connector Server, and select Properties.

12. In the Virtual Machine Properties window, click the Guest OS Customization tab.

13. Select Enable guest customization, then click OK.

14. In the My Cloud panel, select vApps, then right-click the console icon of the vCloud Connector Server and select Start.

15. When the Server on vCloud Director 1.5 is in running state, click VMs in the My Clouds panel and make a note of the IP address of the Server VM.
   
   You need the IP address later in the registration process.

Set Up NAT Mapping for vCloud Connector Server in vCloud Director 1.5

If you select a NAT-based network connection when you deploy your vCloud Connector Server, you need to set up NAT mapping and firewall rules.

There are multiple approaches to managing this issue. Decide whether you wish to use NAT to forward only the ports necessary for vCloud Connector operation or to forward all ports and then set up a firewall rule to filter all but the following required ports:

- Port 443: For communication between vCloud Connector Server and Nodes and between Nodes. This port is used when SSL is enabled; when SSL is disabled, port 80 is used.
- Port 5480: For communication with the vCloud Connector Server Admin Web admin console, for example during the registration process.
Prerequisites

Your appliance is deployed and you are logged on to the vCloud Director Web console as Organization Administrator or System Administrator.

Procedure

1. Click the **Administration** tab, then select **Networks** in the left panel.
2. Find the network you are using in the Networks list, right-click, and select **Configure Services**.
3. In the Configure Services dialog box, click the **NAT Mapping** tab and click **Add** at the bottom of the popup to create the NAT rule.
   
   The Add NAT Rule popup appears.
4. Select one of the External IP addresses from the drop-down list.
   
   Note this address if you plan to set up a firewall rule.
5. If you wish to NAT all ports, enter * for the first port entry.
   
   If you wish to NAT only the required ports, create a rule for each port.
6. Enter the internal IP address from your initial setup and match the port entry for this rule.
7. Click **OK** and click **OK** again.
8. If you are using a firewall rule to control traffic, click the **Firewall** tab and select the **Enable firewall** check box.
9. Click **Add** at the bottom of the pop-up to create a new firewall rule.
   
   Create a rule for each necessary port.
   
   The Add Firewall Rule popup appears.
10. Give the rule a name and select the **Incoming** option.
11. Type the source IP address and the source port.
   
   For incoming traffic, the source is the external network. This is the address you selected in Step 4 above.
12. Type the destination IP address and port.
   
   The destination IP address is the internal IP address from your initial setup.
13. Select the **Allow** action.
14. Select the **Enabled** check box.
15. Click **OK** and **OK** to create the rule.

Install vCloud Connector Server in vCloud Director 5.1

You can install vCloud Connector Server in vCloud Director 5.1.

You must have at least Organization Administrator access in the vCloud Director cloud on which you install the vCloud Connector Server.

**Note**: If you install vCloud Connector Server in a public cloud, you can only connect to public clouds in your vCloud Connector UI.

1. **Add the vCloud Connector Server to a vCloud Director 5.1 Catalog as a vApp Template** on page 24

   Before you can deploy a vCloud Connector Server in a vCloud Director 5.1 cloud, you must upload the virtual appliance to a catalog as a vApp template. You do not need to upload an additional template if a template is already uploaded to a master catalog that multiple organizations share.
Create the vCloud Connector Server from the Template in a vCloud Director 5.1 Cloud on page 24
After the vCloud Connector Server is added to the vCloud Director 5.1 cloud as a template, you can use it to create a running instance on that cloud.

Set Up NAT Mapping for vCloud Connector Server in vCloud Director 5.1 on page 26
If you select a NAT-based network connection when you deploy your vCloud Connector Server, you need to set up NAT mapping and firewall rules.

Add the vCloud Connector Server to a vCloud Director 5.1 Catalog as a vApp Template
Before you can deploy a vCloud Connector Server in a vCloud Director 5.1 cloud, you must upload the virtual appliance to a catalog as a vApp template. You do not need to upload an additional template if a template is already uploaded to a master catalog that multiple organizations share.

Prerequisites
You must have Organization Administrator or System Administrator access on the vCloud Director cloud on which you install the vCloud Connector Server. You must have the unzipped version of the template you downloaded in “Download the vCloud Connector Virtual Appliances,” on page 19.

Procedure
1. Log on to the vCloud Director Web console using a supported browser.
2. Click Catalogs.
   If you log on as System Administrator, select your organization first, then click the Catalogs tab.
3. Select the catalog to which you want to upload the vCloud Connector Server, then click the vApp Templates tab.
4. Click the Upload icon.
5. In the Upload OVF package as a vApp Template popup, click Browse and select the vCloud Connector Server OVF file that you downloaded.
6. Specify a name and, optionally, a description, for the vApp template.
7. Select the virtual datacenter, catalog, and storage profile for the template.
8. Click Upload.

The upload process begins. You can monitor the status of the upload in the Transfer Progress popup.

Note: It may take several seconds after the upload itself has finished for the process to finalize in the cloud.

Create the vCloud Connector Server from the Template in a vCloud Director 5.1 Cloud
After the vCloud Connector Server is added to the vCloud Director 5.1 cloud as a template, you can use it to create a running instance on that cloud.

Prerequisites
You have System Administrator or Organization Administrator access on the vCloud Director cloud on which you install the vCloud Connector Server.

Procedure
1. In the vApp Templates tab of the catalog to which you uploaded the vCloud Connector Server, right-click the name of the Server template and select Add to My Cloud.
2 Read and accept the EULA and click **Next**.

3 Give the Server vApp an easily identifiable name, provide a description, and click **Next**.
   Default lease information is displayed; you can modify the leases later through the vApp properties settings.

4 In the Configure Resources page
   a Select the virtual datacenter in which to store the Server vApp.
   b Provide a name for the virtual machine. This name is displayed in the vCloud Connector UI to identify your Server.
   c Select a Storage Profile.
   d Click **Next**.

5 Select an appropriate network from the **Destination** drop-down menu.
   Unless all your vCloud Connector Nodes and the vCloud Connector Server are behind the same firewall, you need to select a network that is configured to access the Internet. Ask your Service Provider or Network Administrator for more information.

6 Select the appropriate IP Assignment from the drop-down menu and click **Next**.
   If there is a static IP pool, that is probably a reasonable choice. Ask your Service Provider or Network Administrator for more information. If your provider uses NAT, you will need to set up NAT mapping after your Server is deployed. See “Set Up NAT Mapping for vCloud Connector Server in vCloud Director 5.1,” on page 26.

7 In the Networking Properties page, use the information you collected before you began installing vCloud Connector to specify the DNS server, IP address, Netmask, and Default Gateway. If you are using DHCP, leave the fields blank.

8 In the Ready to Complete page, review your settings and click **Finish**.

9 Click the **My Cloud** tab, then select **vApps** in the My Cloud panel.
   You can see the vApp being created in the vApps section.

10 Select **VMs** in the My Cloud panel, right-click your vCloud Connector Server, and select **Properties**.

11 In the Virtual Machine Properties page, click the **Guest OS Customization** tab.

12 Check **Enable guest customization**.

13 Click **OK**.

14 In the My Cloud panel, select **vApps**, then right-click the console icon of your vCloud Connector Server and select **Start**.

15 When the vCloud Connector Server is in running state, click **VMs** in the My Cloud panel and make a note of the IP address of your Server.
   You need the IP address later in the registration process.
Set Up NAT Mapping for vCloud Connector Server in vCloud Director 5.1

If you select a NAT-based network connection when you deploy your vCloud Connector Server, you need to set up NAT mapping and firewall rules.

There are multiple approaches to managing this issue. Decide whether you wish to use NAT to forward only the ports necessary for vCloud Connector operation or to forward all ports and then set up a firewall rule to filter all but the following required ports:

- Port 443: For communication between vCloud Connector Server and Node and between Nodes. This port is used when SSL is enabled; when SSL is disabled, port 80 is used.
- Port 5480: For communication with the vCloud Connector Server Admin Web console, for example during the registration process.

Prerequisites

Your appliance is deployed and you are logged on to the vCloud Director Web console.

Procedure

1. Click the Administration tab and select Virtual Datacenters in the left panel.
2. Double-click your virtual datacenter.
3. Click the Org vDC Networks tab.
4. Find the network you are using in the list of networks, right-click, and select Configure Services.
5. Click the NAT tab.
6. Click Add DNAT to add the rule.
   - The Add Destination NAT Rule pop-up appears.
7. Specify the external IP address.
8. If you wish to NAT all ports, enter * for the first port entry.
    - If you wish to NAT only the required ports, create a rule for each port.
9. Enter the internal IP address from your initial setup and match the port entry for this rule.
10. Click OK and click OK again.
11. If you are using a firewall rule to control traffic, click the Firewall tab and select the Enable firewall check box.
12. Click Add at the bottom of the page to create a new firewall rule.
    - Create a rule for each required port.
    - The Add Firewall Rule popup appears.
13. Select the Enabled check-box.
14. Give the rule a name.
15. Type the source IP address and the source port.
    - For incoming traffic, the source is the external network. This is the address you selected in Step 7 above.
16. Type the destination IP address and port.
    - The destination IP address is the internal IP address from your initial setup.
17. Select the protocol.
18. Select Allow.
19  Click OK and OK to create the rule.

Configure vCloud Connector Server

You use the vCloud Connector Server Admin Web console to do basic configuration tasks, such as defining your time zone, specifying proxy servers, or setting log levels. What you need to do depends on your particular installation.

The vCloud Connector Server Admin Web console interface is divided into five tabs, with the first three tabs, System, Network, and Update, and part of the fourth, Server, being used for general configuration.

Prerequisites

The vCloud Connector Server instance is running and you have the IP address for it that you wrote down when you installed it. You also have the information you gathered in “Collect Necessary Information,” on page 16.

Procedure

1  Go to the vCloud Connector Server Admin Web console at https://<vCC Server IP address>:5480.
2  If you receive a certificate warning, accept the certificate.
3  Log on to the Server Admin Web console as admin.  
   The default password is vmware. Check the Web console title to confirm that you are configuring the vCloud Connector Server.
4  Use the information you collected in “Collect Necessary Information,” on page 16 to complete general configuration.
5  When you have finished with general configuration, keep the Server Admin Web console page open to the Server tab in your browser.

System Tab - Server

The System tab provides general information on the vCloud Connector Server virtual appliance, allows you to configure time zones, and lets you shut down and reboot the appliance.

Information

The Information tab provides general information on the virtual appliance, such as the version number and the host name. You can also reboot and shut down the Server from here.

Time Zone

The Time Zone tab allows you to set your local time zone. Click System Time Zone to see a drop-down list displaying time zones of the world. Select a time zone and click Save Settings.

Note  Changes in time zone settings are not reflected in logs, etc. until the service is reset. Click Reboot in the Information tab to restart the Server.

The virtual hardware clock is always maintained in UTC, which the virtual appliance converts to local time. Correct local time is important for the update repository and VMware Update Manager.
Network Tab - Server

On the Network tab, you can view network related information about the appliance, switch between DHCP and static IP addresses, and set up proxy information.

Status

The Network Status tab provides already configured network information about your appliance, such as DNS servers, network interfaces, and IP addresses. Click Refresh to update your information.

Address

The Network Address Settings tab allows you to specify static IP information for your appliance or to retrieve IP settings from a DHCP server.

**Note** If you set a static IP address you must make sure that there are values for all of the displayed fields. In vCloud Director installations, you must set Preferred and Alternate DNS servers manually. Talk to your Service Provider or Network Admin for the appropriate addresses. You recorded the information that you need for these settings in “Collect Necessary Information,” on page 16.

For more information about network paths in data transfers, see Chapter 7, “Cross-Cloud Data Transfer and Network Connectivity,” on page 59.

Click Save Settings to accept any changes that you made to the network address settings. Click Cancel Changes to discard the changes.

**Note** If you are using static IP settings, and you update the hostname and IP settings at the same time, only the IP settings are saved. The hostname is not saved. Update the Hostname field separately.

Also note that if you change the IP address, you will not see your changes until you log out and log back in to the Admin Web console using the new IP address.

Proxy

The Proxy Settings tab allows you to set up any necessary proxy settings, including address and port. Set this if the appliance must use a proxy to reach systems beyond the firewall at the installation location.

You recorded the information that you need for these settings in “Collect Necessary Information,” on page 16.

Click Save Settings to accept any changes that you made to the proxy settings. Click Cancel Changes to discard the changes.

Update Tab - Server

The Update tab allows you to check the update status of your virtual appliance and to set your update policy.

Status

The Status section allows you to view information about your virtual appliance or to check for and install updates. Click Check Updates to check for updates from the update repository, shown in the Available Updates pane. Click Install Updates to install the updates.

Settings

The Update Settings section allows you to determine when you want to check for updates. You should leave the Use Default Repository button selected. Save any changes you make by clicking Save Settings.
Server Tab

The Server tab has two parts. One part allows you to change the Server administrator password, adjust log levels, and manage SSL certificates. The other part is used later, in the registration process.

General

The General Settings section allows you to change the administrator password for the vCloud Connector Server, provide a license key to enable advanced features in the vCloud Connector Advanced edition, set log file severity levels, and download log files.

<table>
<thead>
<tr>
<th>Change admin user password</th>
<th>Specify a new administrator password for the vCloud Connector Server, then click Confirm new password. You should change the default password.</th>
</tr>
</thead>
<tbody>
<tr>
<td>vCC License</td>
<td>To enable advanced features that are available in the vCloud Connector Advanced edition, enter a valid vCloud Suite 5.1 license key, then click Update Key.</td>
</tr>
<tr>
<td>Log levels</td>
<td>Set the severity level for vCloud Connector Server log files, then click Change log level.</td>
</tr>
<tr>
<td>Download logs</td>
<td>Click to download a zip file of vCloud Connector Server log files.</td>
</tr>
</tbody>
</table>

SSL

The Manage SSL Certificates section allows you to disable or enable SSL and to manage your certificates. vCloud Connector Server has SSL disabled by default and includes a self-signed certificate. Before going into production, replace the certificate with a valid certificate.

| Disable SSL/Enable SSL      | Select Enable SSL if you want to enable HTTPS communication. When you enable SSL, the port used to communicate with the vCloud Connector Server changes from 80 to 443. |
|                            | If you enable SSL for the Server, replace its self-signed certificate with a valid certificate. |
| Key Info                    | Displays information about the default key provided. |
| Certificate Info            | Displays information about the self-signed certificate that is provided with the vCloud Connector Server. |
| Generate New Key            | If you need to generate a new private key to obtain a valid certificate from your Certificate Authority, specify the required information and click Generate Key. In the Common Name field, specify the IP address or fully-qualified domain name of the vCloud Connector Server. For example, 10.10.10.10 or myServer.mycompany.com. You can only generate a 1024-bit key from the UI; to generate a 2048-bit key, use the command line interface. Note: Fields in this section do not support multi-byte characters. Use only ASCII characters for the values you enter. If you enter non-ASCII characters, a garbled value is displayed. |
| Generate and download CSR   | Click to create a Certificate Signing Request and save it to your computer. Use the saved hcserver.csr file to get a certificate from your Certificate Authority. |
| Upload a new X.509 SSL Certificate | Once you have your certificate, use the Browse button to locate it, then click Upload. |

For more information on installing valid certificates, see “Add Valid SSL Certificates,” on page 45.

vSphere Client Tab

This tab is used to register the vCloud Connector UI. For more information, see “Register the vCloud Connector UI,” on page 43.
Nodes Tab

The Nodes tab in the Server Admin Web Console lets you register vCloud Connector Nodes with your vCloud Connector Server, download Node log files, and register Stretch Deploy settings.

Manage Nodes

In the Manage Nodes section, you can view the vCloud Connector Nodes that are currently registered with the vCloud Connector Server and perform tasks related to Nodes.

Table 4-8. Options

<table>
<thead>
<tr>
<th>Task</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>To register a Node with the Server</td>
<td>Click Register Node. See “Register vCloud Connector Nodes with vCloud Connector Server,” on page 42.</td>
</tr>
<tr>
<td>To edit a Node’s registration</td>
<td>Click the gears icon next to the Node and select Edit.</td>
</tr>
<tr>
<td>To unregister a Node from the Server</td>
<td>Click the gears icon next to the Node and select Unregister.</td>
</tr>
<tr>
<td>To download Node log files</td>
<td>Click the gears icon next to the Node and select Download Logs.</td>
</tr>
<tr>
<td>To specify Stretch Deploy settings</td>
<td>Click the gears icon next to the Node and select Stretch Deploy Settings. See Using Stretch Deploy in Using vCloud Connector.</td>
</tr>
<tr>
<td>To unregister Stretch Deploy settings</td>
<td>Click the gears icon next to the Node and select Unregister Stretch Deploy Settings. See Using Stretch Deploy in Using vCloud Connector.</td>
</tr>
</tbody>
</table>

Install vCloud Connector Nodes

You can install vCloud Connector Nodes in vSphere or vCloud Director clouds.

You must install a vCloud Connector Node in every cloud you want to connect and oversee using vCloud Connector.

vCloud Connector does not require every organization in a vCloud Director cloud to install its own vCloud Connector Node in the cloud. If you are a public vCloud service provider hosting many organizations, you can choose to install one Node in the cloud and make it available to multiple organizations. Similarly, if you have a private vCloud Director cloud with many organizations, you can install one Node that will be used by multiple organizations.

If you are a user of a service provider’s public vCloud or of a private vCloud that already has a vCloud Connector Node installed, you need to get the Node URL from your service provider or system administrator. You then register the Node with your vCloud Connector Server using the Node URL and your own Organization credentials.

Install vCloud Connector Node in vSphere

You can install a vCloud Connector Node in vSphere 4.0, 4.1, 5.0, or 5.1.

Prerequisites

You must have administrator-level access on the vSphere in which you install the vCloud Connector Node. You must have the unzipped version of the template you downloaded in “Download the vCloud Connector Virtual Appliances,” on page 19.
Procedure

1. Log on to vSphere Client.

2. Select File > Deploy OVF template.

3. Click Browse and navigate to the OVF directory of the Node file you downloaded to your desktop in “Download the vCloud Connector Virtual Appliances,” on page 19.

4. Click Next.

5. Proceed through the wizard.

   You can either set networking properties in the wizard or set those properties when you configure your server. Set proxy information during the configuration step.

   **NOTE** If you are going to use a static IP address, you need to assign it here.

6. In vSphere Client, select Inventory > VMs and Templates to see the created virtual machine in the hierarchy tree.

7. Right-click the virtual machine and select Power > Power on to power on the machine.

8. Click the Summary tab and find the vCloud Connector Node’s IP address in the General section. The IP address field (not the Host field) displays the IP address of the Node. Make a note of the IP address. You will need it later in the process.

Install vCloud Connector Node in vCloud Director 1.5

You install a vCloud Connector Node in each vCloud Director 1.5 cloud you want to connect to and use with vCloud Connector.

If you are a public vCloud service provider hosting many organizations or if you have a private vCloud Director cloud with many organizations, you can choose to install one vCloud Connector Node in the cloud, instead of installing a Node for each organization. A single vCloud Connector Node can be used by multiple organizations on the cloud to transfer content to and from the cloud.

If you are a service provider or the system administrator of a vCloud Director cloud and you choose to install a vCloud Connector Node for multiple organizations to use, you need to

- Install a Node on the cloud.
- Configure the Node.
- Provide information about the Node (the Node URL) to each organization that will use it.

If you are a user, that is, an organization, of a private or public vCloud Director cloud, you need to

- Check with your service provider or system administrator if a vCloud Connector Node is already deployed on the cloud that you can use.
- If a Node is already deployed on the cloud, you need to get information about the Node (the Node URL) from the service provider or system administrator. You require this information to register the Node with your vCloud Connector Server.
- If a vCloud Connector Node is not already deployed on the cloud, follow the procedures in this section to install a Node for your organization.

Procedure

1. Add the vCloud Connector Node to a vCloud Director 1.5 Catalog as a vApp Template on page 32

   Before you can deploy a vCloud Connector Node in a vCloud Director 1.5 cloud, you must upload the virtual appliance to a catalog as a vApp Template. If the template has already been uploaded and put in a master catalog shared by multiple organizations, you can skip this step.
Create the vCloud Connector Node from the Template in a vCloud Director 1.5 Cloud on page 32
After the vCloud Connector Node is added to the vCloud Director 1.5 cloud as a template, you can use it to create a running instance on that cloud.

Set Up NAT Mapping for vCloud Connector Node in vCloud Director 1.5 on page 33
If you select a NAT-based network connection when you deploy your vCloud Connector Node, you need to set up NAT mapping and firewall rules.

Add the vCloud Connector Node to a vCloud Director 1.5 Catalog as a vApp Template
Before you can deploy a vCloud Connector Node in a vCloud Director 1.5 cloud, you must upload the virtual appliance to a catalog as a vApp Template. If the template has already been uploaded and put in a master catalog shared by multiple organizations, you can skip this step.

Prerequisites
You must have System Administrator or Organization Administrator access on the vCloud Director cloud on which you install the vCloud Connector Node. You must have the unzipped version of the template you downloaded in “Download the vCloud Connector Virtual Appliances,” on page 19.

Procedure
1 Log on to the vCloud Director Web console using a supported browser.
2 Click Catalogs.
   If you log on as System Administrator, select your organization first, then click the Catalogs tab.
3 Double-click the catalog to which you want to upload the vCloud Connector Node, then click the vApp Templates tab.
4 Click the Upload icon.
5 In the Upload OVF package as a vApp Template dialog box, click Browse, accept the security certificate if you are prompted to do so, and select the Node OVF file that you downloaded.
6 Specify a name and, optionally, a description, for the vApp template.
7 Select the virtual datacenter and catalog for the template.
8 Click Upload.

The upload process begins. You can monitor the status of the upload in the Transfer Progress popup.

NOTE It may take several seconds after the upload itself has finished for the process to finalize in the cloud.

Create the vCloud Connector Node from the Template in a vCloud Director 1.5 Cloud
After the vCloud Connector Node is added to the vCloud Director 1.5 cloud as a template, you can use it to create a running instance on that cloud.

Prerequisites
You have System Administrator or Organization Administrator access on the vCloud Director on which you install the vCloud Connector Node.

Procedure
1 In the vApp Templates tab of the catalog to which you uploaded, right-click the name of your vCloud Connector Node template and select Add to My Cloud.
   The Add to My Cloud popup appears.
2 Give the Node vApp an easily identifiable name and provide a description.
3 Set the leases for the Node vApp, then click **Next**.

4 Read and accept the EULA, and click **Next**.

5 Select an appropriate network from the **Network** drop-down menu.

   Unless all the Nodes controlled by your vCloud Connector Server are behind the same firewall, you need to select a network that is configured to access the Internet. Ask your Service Provider or Network Administrator for more information.

6 Select the appropriate IP Assignment from the drop-down menu and click **Next**.

   If there is a static IP pool, that is probably a reasonable choice. Ask your Service Provider or Network Administrator for more information. If your provider uses NAT, you will need to set up NAT mapping after your Node is deployed. See “Set Up NAT Mapping for vCloud Connector Node in vCloud Director 1.5,” on page 33.

7 In the Networking Properties page, use the information you collected before you began installing vCloud Connector to specify the DNS server, IP address, Netmask, and Default Gateway. If you are using DHCP, leave the fields blank.

8 In the Configure Networking page, leave both check boxes unchecked and click **Next**.

9 In the Ready to Complete page, review the settings and click **Finish**.

10 In the **My Cloud** tab, then select **vApps** in the My Cloud panel.

   You see the vApp being created.

11 In the My Cloud panel, select **VMs**, then right-click your vCloud Connector Node virtual machine and select **Properties**.

12 On the Virtual Machine Properties page, click the **Guest OS Customization** tab.

13 Check **Enable guest customization**, then click **OK**.

14 In the My Cloud panel, select **vApps**, then right-click the console icon of the vCloud Connector Node and select **Start**.

15 When the vCloud Connector Node on vCloud Director 1.5 is in running state, click **VMs** in the My Cloud panel and make a note of the IP address of the vCloud Connector Node virtual machine.

   You need the IP address later in the registration process.

**Set Up NAT Mapping for vCloud Connector Node in vCloud Director 1.5**

If you select a NAT-based network connection when you deploy your vCloud Connector Node, you need to set up NAT mapping and firewall rules.

There are multiple approaches to managing this issue. Decide whether you wish to use NAT to forward only the ports necessary for vCloud Connector operation or to forward all ports and then set up a firewall rule to filter all but the following required ports:

- **Port 443**: For communication between vCloud Connector Server and Nodes and between Nodes. This port is used when SSL is enabled; when SSL is disabled, port 80 is used.
- **Port 5480**: For communication with the vCloud Connector Node Admin Web console, for example during the registration process.

**Prerequisites**

Your appliance is deployed and you are logged on to the vCloud Director Web console.

**Procedure**

1 Click the **Administration** tab and select **Networks** in the left panel.
2 Find the network you are using in the Networks list, right-click and select **Configure Services**.

3 In the Configure Services dialog box, click the **NAT Mapping** tab and click **Add** at the bottom of the tab to create the NAT rule.

   The Add NAT Rule popup appears.

4 Select one of the External IP addresses from the drop-down list.
   Note this address if you plan to set up a firewall rule.

5 If you wish to NAT all ports, enter * for the first port entry.
   If you wish to NAT only the required ports, create a rule for each port.

6 Enter the internal IP address from your initial setup and match the port entry for this rule.

7 Click **OK** and click **OK** again.

8 If you are using a firewall rule to control traffic, click the **Firewall** tab and select the **Enable firewall** check box.

9 Click **Add** at the bottom of the pop-up to create a new firewall rule.

   Create a rule for each necessary port.

   The Add Firewall Rule popup appears.

10 Give the rule a name and select the **Incoming** radio button.

11 Type the source IP address and the source port.
   For incoming traffic, the source is the external network. This is the address you selected in Step 4 above.

12 Type the destination IP address and port.
   The destination IP address is the internal IP address from your initial setup.

13 Select the **Allow** option.

14 Select the **Enabled** option.

15 Click **OK** and **OK** to create the rule.

### Install vCloud Connector Node in vCloud Director 5.1

You install a vCloud Connector Node in each vCloud Director 5.1 cloud you want to connect to and use with vCloud Connector.

If you are a public vCloud service provider hosting many organizations or if you have a private vCloud Director cloud with many organizations, you can choose to install one vCloud Connector Node in the cloud, instead of installing a Node for each organization. A single vCloud Connector Node can be used by multiple organizations on the cloud to transfer content to and from the cloud.

If you are a vCloud Service Provider or the system administrator of a vCloud Director cloud and you choose to install a vCloud Connector Node for multiple organizations to use, you need to:

- Install a vCloud Connector Node on the cloud.

- Configure the Node.

- Provide information about the Node (the Node URL) to each organization that will use it.

If you are a user, that is, an organization, of a vCloud Director private or public cloud, you need to:

- Check with your service provider or system administrator if a vCloud Connector Node is already deployed on the cloud that you can use.
If a vCloud Connector Node is already deployed on the cloud, you need to get information about the Node (the Node URL) from the service provider or system administrator. You require this information to register the Node with your vCloud Connector Server.

If a vCloud Connector Node is not already deployed on the cloud, follow the procedures in this section to install a Node for your organization.

1 **Add the vCloud Connector Node to a vCloud Director 5.1 Catalog as a vApp Template** on page 35

   Before you can deploy a vCloud Connector Node in a vCloud Director 5.1 cloud, you must upload it to a catalog as a vApp template. If the template has already been uploaded and put in a master catalog shared by multiple organizations, you can skip this step.

2 **Create the vCloud Connector Node from the Template in a vCloud Director 5.1 Cloud** on page 36

   After the vCloud Connector Node is added to the vCloud Director 5.1 cloud as a template, you can use it to create a running instance on that cloud.

3 **Set Up NAT Mapping for vCloud Connector Node in vCloud Director 5.1** on page 37

   If you select a NAT-based network connection when you deploy your vCloud Connector Node, you need to set up NAT mapping and firewall rules.

---

**Add the vCloud Connector Node to a vCloud Director 5.1 Catalog as a vApp Template**

Before you can deploy a vCloud Connector Node in a vCloud Director 5.1 cloud, you must upload it to a catalog as a vApp template. If the template has already been uploaded and put in a master catalog shared by multiple organizations, you can skip this step.

**Prerequisites**

You must have System Administrator or Organization Administrator access on the vCloud Director cloud on which you install the vCloud Connector Node.

**Procedure**

1 Log on to the vCloud Director Web console using a supported browser.

2 Click **Catalogs**.

   If you log on as System Administrator, select your organization first, then click the **Catalogs** tab.

3 Select the catalog to which you want to upload the vCloud Connector Node, then click the **vApp Templates** tab.

4 Click the **Upload** icon.

5 In the Upload OVF package as a vApp Template popup, click **Browse** and select the Node OVF file that you downloaded.

6 Specify a name and, optionally, a description, for the vApp template.

7 Select the virtual datacenter, catalog, and storage profile for the template.

8 Click **Upload**.

The upload process begins. You can monitor the status of the upload in the **Transfer Progress** popup.

---

**NOTE** It may take several seconds after the upload itself has finished for the process to finalize in the cloud.
Create the vCloud Connector Node from the Template in a vCloud Director 5.1 Cloud

After the vCloud Connector Node is added to the vCloud Director 5.1 cloud as a template, you can use it to create a running instance on that cloud.

Prerequisites

You have System Administrator or Organization Administrator access on the vCloud Director cloud on which you install the vCloud Connector Node.

Procedure

1. In the vApp Templates tab of the catalog to which you uploaded the vCloud Connector Node, right-click the name of the Node template and select Add to My Cloud.
2. Read and accept the EULA and click Next.
3. Give the Node vApp an easily identifiable name, provide a description, and click Next.
   Default lease information is displayed; you can modify the leases later through the vApp properties settings.
4. In the Configure Resources page
   a. Select the virtual datacenter in which to store the Node vApp.
   b. Provide a name for the virtual machine.
   c. Select a Storage Profile.
   d. Click Next.
5. Select an appropriate network from the Destination drop-down menu.
   Unless all the vCloud Connector Nodes controlled by your vCloud Connector Server are behind the same firewall, you need to select a network that is configured to access the Internet. Ask your Service Provider or Network Administrator for more information.
6. Select the appropriate IP Allocation from the drop-down menu and click Next.
   If there is a static IP pool, that is probably a reasonable choice. Ask your Service Provider or Network Administrator for more information. If your provider uses NAT, you will need to set up NAT mapping after your Node is deployed. See “Set Up NAT Mapping for vCloud Connector Node in vCloud Director 5.1,” on page 37.
7. In the Networking Properties page, use the information you collected before you began installing vCloud Connector to specify the DNS server, IP address, Netmask, and Default Gateway. If you are using DHCP, leave the fields blank.
8. In the Ready to Complete page, review the settings and click Finish.
9. Click the My Cloud tab, then select vApps in the My Cloud panel.
   You see the vApp being created.
10. After the vApp is created, select VMs in the My Cloud panel, right-click your vCloud Connector Node, and select Properties.
11. In the Virtual Machine Properties page, click the Guest OS Customization tab.
12. Check Enable guest customization.
13. Click OK.
14. In the My Cloud panel, select vApps, then right-click the console icon of your Node and select Start.
When the Node is in running state, select VMs in the My Cloud panel and make a note of the IP address of your Node.

You need the IP address later in the registration process.

**Set Up NAT Mapping for vCloud Connector Node in vCloud Director 5.1**

If you select a NAT-based network connection when you deploy your vCloud Connector Node, you need to set up NAT mapping and firewall rules.

There are multiple approaches to managing this issue. Decide whether you wish to use NAT to forward only the ports necessary for vCloud Connector operation or to forward all ports and then set up a firewall rule to filter all except the following required ports:

- Port 443: For communication between vCloud Connector Server and Nodes and between Nodes. This port is used when SSL is enabled; when SSL is disabled, port 80 is used.
- Port 5480: For communication with the vCloud Connector Node Admin Web console, for example during the registration process.

**Prerequisites**

Your appliance is deployed and you are logged on to the vCloud Director Web console.

**Procedure**

1. Click the **Administration** tab and select **Virtual Datacenters** in the left panel.
2. Double-click your virtual datacenter.
3. Click the **Org vDC Networks** tab.
4. Find the network you are using in the list of networks, right-click, and select **Configure Services** from the popup menu.
5. Click the **NAT** tab.
6. Click **Add DNAT** to add the rule.
   
   The Add Destination NAT Rule form appears.
7. Specify the external IP address.
8. If you wish to NAT all ports, enter * for the first port entry.
   
   If you wish to NAT only the required ports, create a rule for each port.
9. Enter the internal IP address from your initial setup and match the port entry for this rule.
10. Click **OK** and click **OK** again.
11. If you are using a firewall rule to control traffic, click the **Firewall** tab and select the **Enable firewall** check box.
12. Click **Add** at the bottom of the page to create a new firewall rule.
   
   Create a rule for each required port.
   
   The Add Firewall Rule popup appears.
13. Select the **Enabled** check-box.
14. Give the rule a name.
15. Type the source IP address and the source port.
   
   For incoming traffic, the source is the external network. This is the address you selected in Step 7 above.
16 Type the destination IP address and port. The destination IP address is the internal IP address from your initial setup.
17 Select the protocol.
18 Select Allow.
19 Click OK and OK to create the rule.

**Register vCloud Connector Nodes with Clouds**

After you install a vCloud Connector Node for a cloud, you need to register it with the cloud.

In a public or private vCloud Director environment in which one vCloud Connector Node is deployed as a multi-tenant node for use by multiple organizations, the system administrator of the cloud performs this task.

**Prerequisites**
The vCloud Connector Node is powered on and you have its IP address.

**Procedure**

2. Log on as admin. If you have not changed the password, use vmware, the default password.
3. Click the Node tab, then the Cloud tab.
4. In the Cloud Type field, select the type of cloud in which the vCloud Connector Node is installed: vSphere or vCloud Director.
5. In the Cloud URL field, specify the URL of the cloud. You can specify either the IP address of the cloud or its fully qualified domain name (FQDN):
   - ![Image](https://<Cloud_IP_address>)
     For example: https://10.10.100.10
   - ![Image](https://<Fully_Qualified_Domain_Name_of_Cloud>)
     For example: https://cloud1.company.com
6. Select Ignore SSL Certificate if the cloud does not have a valid SSL certificate.
   **NOTE** If the cloud has a valid certificate, deselect this option. Also, import the root certificate of the Certificate Authority that issued the cloud’s certificate into the trusted keystore of the vCloud Connector Node. See “Add CA Root Certificate to Trusted Keystore,” on page 49 for information on importing the certificate.
7. Select Use Proxy if there is an HTTP proxy server between the vCloud Connector Node and the cloud.
   **NOTE** If you select this option, you must also specify proxy settings in the Network - Proxy tab.
8. Click Update Configuration.

The vCloud Connector Node is registered with the cloud.

**What to do next**

Configure your vCloud Connector Node by using the settings in the other tabs of the vCloud Connector Node Admin Web console.
Configure vCloud Connector Nodes

You use the vCloud Connector Node Admin Web console for each of your Nodes to do basic configuration tasks, such as defining your time zone, specifying proxy servers, or setting log levels. What you need to do depends on your particular installation.

The vCloud Connector Node Admin Web console interface is divided into four tabs: System, Network, Update, and Node.

Prerequisites

The vCloud Connector Node instance is running and you have the IP address for it that you wrote down when you installed it. You have the information you collected in “Collect Necessary Information,” on page 16.

Procedure

2. If you receive a certificate warning, accept the certificate.
3. Log on to the Node Admin Web console as admin.
   The default password is vmware.
   Check the Web console title to make sure you are configuring the vCloud Connector Node.
4. Use the information you collected to complete general configuration as needed.
5. When you finish the general configuration tasks, you can exit the vCloud Connector Node Admin Web console.

System Tab - Node

The System tab provides general information on the virtual appliance, allows you to set time zones, and lets you shut down and reboot the appliance.

Information

The Information tab provides general information on the virtual appliance, such as the version number and the host name. It also contains the Reboot and Shutdown buttons.

Time Zone

The Time Zone tab allows you to set your local time zone. Click System Time Zone to see a drop-down list displaying time zones of the world. Select a time zone and click Save Settings.

Note Changes in time zone settings are not reflected in logs, etc. until the service is reset. Click Reboot in the Information tab to restart.

The virtual hardware clock is always maintained in UTC, which the virtual appliance converts to local time. Correct local time is important for the update repository and VMware Update Manager.

Network Tab - Node

On the Network tab, you can view network related information about the appliance, switch between DHCP and static IP addresses, and set up proxy information.

Status

The Network Status tab provides already configured network information about your appliance, such as DNS servers, network interfaces, and IP addresses. Click Refresh to update your information.
Address

The Network Address Settings tab allows you to specify static IP information for your appliance or to retrieve IP settings from a DHCP server.

**Note** If you set a static IP address you must make sure that there are values for all of the displayed fields. In vCloud Director installations, you must set Preferred and Alternate DNS servers manually. Talk to your Service Provider or Network Admin for the appropriate addresses. You recorded the information that you need for these settings in “Collect Necessary Information,” on page 16.

For more information about network paths in data transfers, see Chapter 7, “Cross-Cloud Data Transfer and Network Connectivity,” on page 59.

Click Save Settings to accept any changes that you made to the network address settings. Click Cancel Changes to discard the changes.

**Note** If you are using static IP settings, and you update the hostname and IP settings at the same time, only the IP settings are saved. The hostname is not saved. Update the Hostname field separately.

Also note that if you change the IP address, you will not see your changes until you log out and log back in to the Admin Web console using the new IP address.

Proxy

The Proxy Settings tab allows you to set up any necessary proxy settings, including address and port. Set this if the appliance must use a proxy to reach systems beyond the firewall at the installation location.

You recorded the information that you need for these settings in “Collect Necessary Information,” on page 16.

Click Save Settings to accept any changes that you made to the proxy settings. Click Cancel Changes to discard the changes.

Update Tab - Node

The Update tab allows you to check the update status of your virtual appliance and to set your update policy.

**Status**

The Status section allows you to view information about your virtual appliance or to check for and install updates. Click Check Updates to check for updates from the update repository, shown in the Available Updates pane. Click Install Updates to install the updates.

**Settings**

The Update Settings section allows you to determine when you want to check for updates. You should leave the Use Default Repository button selected. Save any changes you make by clicking Save Settings.
Node Tab

On the **Node** tab you can change the vCloud Connector Node administrator password, adjust log levels, and manage SSL certificates. You also use this tab to register the vCloud Connector Node with the cloud on which it is installed.

Cloud

In the **Cloud Registration** section, you register the vCloud Connector Node with the cloud on which it is installed.

**Note** For public or private vCloud Director clouds that have only one vCloud Connector Node installed as a multi-tenant node for use by multiple organizations, this task is performed by the service provider or network administrator of the cloud.

<table>
<thead>
<tr>
<th>Cloud Type</th>
<th>The type of the cloud.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cloud URL</td>
<td>The URL of the cloud. You can specify either the IP address of the cloud or its fully qualified domain name (FQDN):</td>
</tr>
<tr>
<td></td>
<td><strong>https://&lt;Cloud_IPaddress&gt;</strong></td>
</tr>
<tr>
<td></td>
<td>For example: <strong><a href="https://10.10.100.10">https://10.10.100.10</a></strong></td>
</tr>
<tr>
<td></td>
<td><strong>https://&lt;Fully_Qualified_Domain_Name_of_Cloud&gt;</strong></td>
</tr>
<tr>
<td></td>
<td>For example: <strong><a href="https://cloud1.company.com">https://cloud1.company.com</a></strong></td>
</tr>
<tr>
<td>Ignore SSL Cert</td>
<td>Select this option if the cloud does not have a valid SSL certificate.</td>
</tr>
<tr>
<td>Note</td>
<td>If the cloud has a valid certificate, deselect this option. Also, import the root certificate of the Certificate Authority that issued the cloud’s certificate into the trusted keystore of the vCloud Connector Node. See “Add CA Root Certificate to Trusted Keystore,” on page 49 for information on importing the certificate.</td>
</tr>
</tbody>
</table>

Use Proxy

Select this option if there is an HTTP proxy server between the vCloud Connector Node and the cloud. If you select this option, you must also specify proxy settings in the **Network - Proxy** tab.

General

The **General Settings** section allows you to change the administrator password for the vCloud Connector Node, set log file severity levels, and download log files.

| Change admin user password | Specify a new administrator password for the vCloud Connector Node, then click **Confirm new password**. You should change the default password. |
| Log levels | Set the severity level for vCloud Connector Node log files, then click **Change log level**. |
| Download logs | Click to download a zip file of vCloud Connector Node log files. If you are using a Node that has been deployed by a public vCloud Service Provider or private vCloud Director cloud system administrator for use by multiple organizations and you do not have access to the Node, you can download your log files from the vCloud Connector Server Admin Web console. |
| Concurrent Tasks Configuration | Specify the maximum number of concurrent tasks that are allowed for the vCloud Connector Node, then click **Change Maximum Concurrent Tasks**. The default is 10. Note that if you increase the concurrent tasks maximum, you should also increase the vCloud Connector Node storage. The amount of storage you need depends upon the size of your tasks. Approximately 50GB is recommended for each added task. See “Increase Maximum Concurrent Tasks,” on page 51 and “Configure vCloud Connector Node Allocated Storage,” on page 50 for more information. |
SSL

The Manage SSL Certificates section allows you to disable or enable SSL and to manage your certificates. vCloud Connector Nodes have SSL enabled by default and include a self-signed certificate. Before going into production, replace the certificate with a valid certificate.

Disable SSL/Enable SSL

Select Disable SSL if you want to disable HTTPS communication. Note that if you disable SSL, the port that is used to communicate with the Node changes from 443 to 80.

**Note**: After you enable or disable SSL for a Node, you must update the Node's registration with the vCloud Connector Server.

Key Info

Displays information about the default key provided.

Certificate Info

Displays information about the self-signed certificate that is provided with vCloud Connector Node.

Generate New Key

If you need to generate a new private key to obtain a valid certificate from your Certificate Authority, type the required information and click Generate Key. In the Common Name field, specify the IP address or fully-qualified domain name of the vCloud Connector Server. For example, 10.10.10.10 or myNode.mycompany.com.

You can only generate a 1024-bit key from the UI; to generate a 2048-bit key, use the command line interface.

**Note**: Fields in this section do not support multi-byte characters. Use only ASCII characters for the values you enter. If you enter non-ASCII characters, a garbled value is displayed.

Generate and download CSR

Click to create a Certificate Signing Request and save it to your computer. Use the saved hcagent.csr file to get a certificate from your Certificate Authority.

Upload a new X.509 SSL Certificate

Once you have your certificates, use the Browse button to locate the root, intermediate, and signed certificates, then click Upload.

You must upload all three certificates. If your Certificate Authority issues only two certificates, upload them from the command line. See “Upload Certificates from the Command Line,” on page 48.

For more information on installing valid certificates, see “Add Valid SSL Certificates,” on page 45.

Register vCloud Connector Nodes with vCloud Connector Server

You use the vCloud Connector Server Admin Web console to register vCloud Connector Nodes with the vCloud Connector Server. The Nodes are installed on vSphere, private vCloud Director clouds, or public vClouds. The registration allows the Server to manage the Nodes.

**Procedure**


   If you receive a certificate error, accept the certificate. vCloud Connector Server has a self-signed certificate.

2. Log on to the Web console as admin.

   If you did not change the password, use vmware, the default password.

3. Click the Nodes tab.

   The Manage Nodes tab contains the list of vCloud Connector Nodes that are currently registered.

   The Local Content Directory Node always appears by default. This node is for Content Sync. Do not edit this Node.

4. Click Register Node.
5 Complete the Node information.

<table>
<thead>
<tr>
<th>Node Info Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the cloud where the vCloud Connector Node is installed. This name is the display name of the cloud in the vCloud Connector UI.</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the vCloud Connector Node. For example, you can specify whether the Node is a service provider Node or a local Node, or provide information about whom to contact if there are any issues.</td>
</tr>
</tbody>
</table>
| URL              | The URL of the Node. You can specify either the IP address of the Node or its fully qualified domain name (FQDN):  
  - https://vCCNode_IPaddress  
  - https://Fully_Qualified_Domain_Name_of_vCCNode  
  For example: https://10.10.100.10  
  - https://node1.company.com  
  You can get the URL of the vCloud Connector Node from its console in the vSphere or vCloud Director cloud in which it is installed. If the Node is on a public vCloud, obtain this information from your service provider. |
| Public           | Select if the cloud is a public cloud outside the firewall where your vCloud Connector Server is installed. |
| Use Proxy        | Select if the vCloud Connector Server needs to use a proxy to reach the vCloud Connector Node that you are registering. |
| Ignore SSL Certificate | Select if you did not install valid certificates.  
  - **Note**: If you did not install valid certificates, and you do not select this option, copying fails. If you select this option, and later install a valid certificate, you must deselect this option and restart the vCloud Connector server. |

6 Complete the cloud information.

<table>
<thead>
<tr>
<th>Cloud Info Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cloud Type</td>
<td>Type of cloud on which the vCloud Connector Node is installed, either vSphere or vCloud Director.</td>
</tr>
<tr>
<td>vCD Org Name</td>
<td>If the vCloud Connector Node is on a vCloud Director cloud, type the name of your organization. You must use a valid organization name. vCloud Connector validates the organization name that you provide with the cloud. If you selected vSphere in the Cloud Type option, this field is disabled.</td>
</tr>
<tr>
<td>Username</td>
<td>User name for the cloud in which the vCloud Connector Node is installed.</td>
</tr>
<tr>
<td>Password</td>
<td>Password for the cloud in which the vCloud Connector Node is installed.</td>
</tr>
</tbody>
</table>

7 Click **Register**.

The Register Node with Server window closes and the vCloud Connector Node appears in the Manage Nodes list. To edit values, unregister the Node, or to download log files for a Node, click the gears icon at the right of the list entry.

- **Note**: Do not update or unregister a vCloud Connector Node while a task is in progress.

### Register the vCloud Connector UI

To surface the vCloud Connector UI, you register it to a vSphere Client.
Register the vCloud Connector UI in vSphere Client

Set up the vCloud Connector UI as a plug-in in vSphere Client using the vCloud Connector Server Admin Web console.

You can register your vCloud Connector UI with only one vSphere Client at a time. To register with another vSphere Client, unregister and then register with the new vSphere Client. Also, a vSphere Client can have only one vCloud Connector instance as a plug-in. To replace it, select the Overwrite existing registration option while registering.

**Note** Because the vSphere Client interface uses the Internet Explorer rendering engine, it also uses the Internet Explorer security and privacy settings. Set your settings at Medium High or below. This setting allows cookies and Javascript, both of which are necessary for the plug-in to work.

**Prerequisites**

You need the information you collected in “Collect Necessary Information,” on page 16. You need the IP address of the vCloud Connector Server and the IP address or fully qualified domain name of the vCenter Server to which the vSphere Client is pointed. You also need an administrator username and password for that vCenter Server.

**Procedure**

2. If you get a certificate error, accept the certificate.
3. Log on as admin. If you have not changed the password, use vmware, the default password.
4. Click the Server tab, then the vSphere Client tab.
5. Type the vCloud Connector Server URL in the following format: https://<vCC Server IP address>.
   - If you are using DHCP, the vCC Server URL text box is automatically populated.
6. Type the vCenter Server IP address or fully qualified domain name.
   - **Note** If your vCenter Server is running on a port other than the default, make sure you indicate the port along with the IP address.
7. Type the user name and password for the vCenter Server.
8. If you have a previously registered version of the vCloud Connector Server that you are replacing with this current version, select Overwrite existing registration.
9. Click Register.
   - To unregister a previous registration, click Unregister. To update an existing registration, click Update Registration.

When the registration is completed, a confirmation message appears at the top of the section.

If you get an error, check the values you entered in the fields. If you did not enter an administrator username and password for the vCenter Server, you will get the following error: "Could not register the plugin: Could not connect to https://<IPaddress>."
Prepare vCloud Connector for Production Use

Before you place vCloud Connector into production use, you must prepare it for a full production environment.

Procedure

1. **Add Valid SSL Certificates** on page 45
   If you have not yet replaced the self-signed certificates in your vCloud Connector Server and vCloud Connector Nodes, you need to do so before production use.

2. **Upload Certificates from the Command Line** on page 48
   In some cases, you need to upload certificates from the command line.

3. **Add CA Root Certificate to Trusted Keystore** on page 49
   When you add valid certificates and enable SSL for a vCloud Connector Node, you must also import the corresponding Certificate Authority (CA) root certificate into the trusted keystore of the vCloud Connector Server and all other vCloud Connector Nodes.

4. **Configure vCloud Connector Node Allocated Storage** on page 50
   Copy operations rely on staging storage when you copy resources between clouds. To successfully copy resources, make sure you have enough storage in your vSphere and vCloud Director clouds.

5. **Increase Maximum Concurrent Tasks** on page 51
   In vCloud Connector, you can start multiple tasks at the same time. By default, vCloud Connector executes a maximum of 10 concurrent tasks per vCloud Connector Node, that is, per cloud. If you specify more than 10 tasks, the first 10 tasks are executed concurrently. When a task finishes, the next one in the queue is executed.

**Add Valid SSL Certificates**

If you have not yet replaced the self-signed certificates in your vCloud Connector Server and vCloud Connector Nodes, you need to do so before production use.

In a production environment, vCloud Connector requires root, intermediate, and signed certificates for the vCloud Connector Server and Nodes. All three certificates are required. The certificates must be in the X.509 format.

If your Certificate Authority (CA) only issues two certificates, you need to upload them from the command-line as the UI does not allow you to upload fewer than three certificates. See “Upload Certificates from the Command Line,” on page 48 for more information.

Certificates are added to the /usr/local/tcserver/vfabric-tc-server-standard/agent_or_server/conf/tcserver.jks keystore.

When you add valid certificates and enable SSL for a Node, you must also import the corresponding CA root certificate into the trusted keystore of the vCloud Connector Server and all other vCloud Connector Nodes. See “Add CA Root Certificate to Trusted Keystore,” on page 49.

**Procedure**

1. Go to the Admin Web console of the vCloud Connector Server or Node at https://<vCCServer_or_Node_IPaddress>:5480.

2. Log on as **admin**.
   The default password is vmware.

3. For vCloud Connector Server, click the **Server** tab, then click the **SSL** tab. For vCloud Connector Node, click the **Node** tab, then click the **SSL** tab.
Create a new private key if your Certificate Authority requires you to do so.

- To generate a 1024-bit key,
  a In the **Generate New Key** section of the Manage SSL Certificates page, specify the following options.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public key algorithm</td>
<td>The encryption algorithm: RSA or DSA</td>
</tr>
<tr>
<td>Public key size</td>
<td>The key size. From the UI, you can only generate a 1024-bit key. Use the command line to generate a 2048-bit key.</td>
</tr>
<tr>
<td>Common Name</td>
<td>The IP address or fully qualified domain name of the Server or Node. For example: 10.10.10.10 or myNode.mycompany.com</td>
</tr>
<tr>
<td>Organizational Unit</td>
<td>Your department name.</td>
</tr>
<tr>
<td>Organization</td>
<td>Your company name.</td>
</tr>
<tr>
<td>Locality</td>
<td>The city in which your company is based.</td>
</tr>
<tr>
<td>State</td>
<td>The state in which your company is based.</td>
</tr>
<tr>
<td>Country Code</td>
<td>The country in which your company is based.</td>
</tr>
</tbody>
</table>

**NOTE** Use only ASCII characters in the fields. If you use non-ASCII characters, they appear garbled.

b Click **Generate Key**.

- To generate a 2048-bit key, use the command line interface.
  a Log on to the vCloud Connector Server or Node console as **admin**. The default password is **vmware**.
  b Change directory. For the Server:
    
    cd /usr/local/tcserver/vfabric-tc-server-standard/server/conf
    
    For the Node:
    
    cd /usr/local/tcserver/vfabric-tc-server-standard/agent/conf
  c Delete the existing key.
    For the Server:
    
    /usr/java/default/bin/keytool -delete -alias hcserver -keystore tcserver.jks -storepass changeme
    
    For the Node:
    
    /usr/java/default/bin/keytool -delete -alias hcagent -keystore tcserver.jks -storepass changeme
  d Generate the new 2048-bit key.
    For the Server:
    
    /usr/java/default/bin/keytool -genkey -keyalg RSA -keysize 2048 -alias hcserver -validity 1095 -keystore tcserver.jks -storepass changeme -keypass changeme
For the Node:

```
/usr/java/default/bin/keytool -genkey -keyalg RSA -keysize 2048 -alias hcagent -validity 1095 -keystore tcserver.jks -storepass changeme -keypass changeme
```

Log out of the console.

5 In the Admin Web console, click **Generate and download CSR** to generate a Certificate Signing Request and download it.

The vCloud Connector Server file is named `hcserver.csr`; the vCloud Connector Node file is named `hcagent.csr`.

6 Obtain certificates from your CA using the `.csr` files you downloaded.

**NOTE** If you are obtaining certificates from a Windows Server 2008 Certificate Authority, select the Subordinate Certificate Authority template type while requesting the certificate.

7 If the certificates you obtain from your CA are not in the X.509 format, convert them to the X.509 format by using the following command at the command prompt:

```
openssl pkcs7 -in <path/../.certificate.cer> -print_certs | openssl x509 > <path/../.certificate.cer>
```

**NOTE** You must have the OpenSSL library installed to access this command. You can also use this command from the Server or Node console.

**NOTE** If the certificate is already in the X.509 format, you might get an error.

8 When you have your certificates in the X.509 format,

a In the **Root CA certificate** field, click **Browse** and find the root certificate for the vCloud Connector Server or Node.

b In the **Intermediate CA certificate** field, click **Browse** and find the intermediate certificate for the vCloud Connector Server or Node.

c In the **Certificate** field, click **Browse** and find the signed certificate for the vCloud Connector Server or Node.

d Click **Upload**.

9 Click **Enable SSL** at the top of the page.

**NOTE** You can ignore the following message: “vCloud Connector server hostname does not match CN in SSL certificate.”

**What to do next**

After you install valid certificates, you must do the following.

- Deselect the **Ignore SSL Certificate** flag for each Node for which you installed a valid certificate and update the Node’s registration with the vCloud Connector Server.

  a Go to the vCloud Connector Server Admin Web console at `https://<vCCServer_IPaddress>:5480`.

  b Log on as `admin`. The default password is `vmware`.

  c Click the **Nodes** tab.

  d Click the gears icon next to the Node and select **Edit**.

  e Deselect **Ignore SSL Certificate**, then click **Update**.

See also “Register vCloud Connector Nodes with vCloud Connector Server,” on page 42.
Restart the vCloud Connector Server after uploading new certificates for the change to take effect.

Upload Certificates from the Command Line

In some cases, you need to upload certificates from the command line.

The vCloud Connector Server and vCloud Connector Node Admin Web consoles support uploading only a single root, intermediate, and signed certificate. To upload multiple root or intermediate certificates, use the command line interface.

Also use the command line interface if you need to upload fewer than three certificates as the UI requires you to upload all three certificates. Some Certificate Authorities only issue two certificates.

Certificates must be in the X.509 format.

You must import certificates in the following order: root certificate, intermediate certificate, then signed certificate.

**Note** If you obtain certificates from a Windows Server 2008 Certificate Authority, ensure that you select the Subordinate Certificate Authority template type while requesting the certificate.

Prerequisites

You have obtained the certificates and have copied them to a directory in the vCloud Connector Server or Node.

Procedure

1. Log on to the console of the vCloud Connector Server or vCloud Connector Node as **admin**.
   The default password is **vmware**.

2. If the certificates that you obtained from your Certificate Authority are not in the X.509 format, convert them to the X.509 format.

   ```
   openssl pkcs7 -in <path/../certificate.cer> -print_certs | openssl x509 > <path/../certificate.cer>
   ```

   **Note** If the certificate is already in the X.509 format, you might get an error.

3. At the prompt, change directory:

   ```
   cd /usr/local/tcserver/vfabric-tc-server-standard/server_or_agent/conf
   ```

4. Import the root certificate.

   ```
   /usr/java/default/bin/keytool -import -trustcacerts -alias root -file <location of root .cer file> -keystore tcservr.jks -storepass changeme
   ```

5. Import intermediate certificates. Ensure that you import multiple intermediate certificates in an order of signing chain.

   ```
   /usr/java/default/bin/keytool -import -trustcacerts -alias intermediate -file <location of intermediate .cer file> -keystore tcservr.jks -storepass changeme
   ```

   **Note** You must provide a unique alias name for every intermediate certificate you upload.

6. Import the signed certificate.

   ```
   /usr/java/default/bin/keytool -import -trustcacerts -alias hcserver_or_hcagent -file <location of .cer file> -keystore tcservr.jks -storepass changeme
   ```
7 Enable SSL.
   a Go to the Server or Node Admin Web console at https://<vCCServerOrNode_IPaddress>:5480.
   b Log on as admin. The default password is vmware.
   c For the Server, click the Server tab, then the SSL tab. For the Node, click the Node tab, then the SSL tab.
   d Click Enable SSL.

   **Note** You can ignore the following message: "vCloud Connector server hostname does not match CN in SSL certificate."

**What to do next**
After you install valid certificates, you must do the following.

- Deselect the Ignore SSL Certificate flag for each Node for which you installed a valid certificate and update the Node’s registration with the vCloud Connector Server.
  a Go to the vCloud Connector Server Admin Web console at https://<vCCServer_IPaddress>:5480.
  b Log on as admin. The default password is vmware.
  c Click the Nodes tab.
  d Click the gears icon next to the Node and select Edit.
  e Deselect Ignore SSL Certificate, then click Update.

See also “Register vCloud Connector Nodes with vCloud Connector Server,” on page 42.

- Restart the vCloud Connector Server after uploading new certificates for the change to take effect.

**Add CA Root Certificate to Trusted Keystore**
When you add valid certificates and enable SSL for a vCloud Connector Node, you must also import the corresponding Certificate Authority (CA) root certificate into the trusted keystore of the vCloud Connector Server and all other vCloud Connector Nodes.

The trusted keystore is /usr/java/default/lib/security/cacerts. The default password for this keystore is changeit.

**Procedure**
1 Log on to the console of the vCloud Connector Server or vCloud Connector Node as admin.
   The default password is vmware.
2 If the CA Root certificate is not in the X.509 format, convert it to the X.509 format.
   openssl pkcs7 -in <path/../certificate.cer> -print_certs | openssl x509 > <path/../certificate.cer>

   **Note** If the certificate is already in the X.509 format, you might get an error.
3 At the prompt, change directory:
   cd /usr/java/default/lib/security

VMware, Inc.  49
4 Import the root certificate.

```
/usr/java/default/bin/keytool -import -trustcacerts -alias alias -file <location of root .cer file> -keystore cacerts -storepass changeit
```

Ensure that all root certificates uploaded to the cacerts keystore have a unique alias name.

---

**Configure vCloud Connector Node Allocated Storage**

Copy operations rely on staging storage when you copy resources between clouds. To successfully copy resources, make sure you have enough storage in your vSphere and vCloud Director clouds.

Default storage on vCloud Connector Nodes is 40 GB. You may need to increase this if you will be copying large virtual machines or templates or if you will be copying many items simultaneously.

You also need to increase the storage if you increase the maximum number of concurrent tasks allowed for a Node.

---

**Configure vCloud Connector Node Allocated Storage in vSphere**

To successfully copy resources to or from a vSphere cloud, you must configure and resize the data disk associated with the vCloud Connector Node for that vSphere cloud.

**Prerequisites**

- You are a vSphere administrator.
- You have taken a snapshot of the virtual appliance.

**Procedure**

1. Log on to the vSphere Client.
2. In the hierarchy tree, select the vCloud Connector Node virtual appliance.
3. Right-click and select **Edit Settings**.
   
   The **Virtual Machine Properties** window opens to the **Hardware** tab.
4. Select **Hard disk 2** in the **Hardware** column.
5. Modify the size, based on the size of the resources you are going to be transferring, and click **OK**.
6. Open the console for the vCloud Connector Node.
7. Run the following command to resize the disk:
   
   ```
   sudo /opt/vmware/hcagent/scripts/resize_disk.sh
   ```

---

**Configure vCloud Connector Node Allocated Storage in vCloud Director**

To successfully copy resources to or from a vCloud Director cloud, you must add disk storage to the vCloud Connector Node associated with that cloud.

To add disk storage in vCloud Director, you must add disks.

**Prerequisites**

You are a vCloud Director Org Administrator. You are logged on to vCloud Director.

**Procedure**

1. Power down the vCloud Connector Node.
2. Click the **My Cloud** tab.
Select VMs in the left panel.

Right-click the console icon of the powered-down vCloud Connector Node in the center panel and select Properties.

In the Virtual Machine Properties popup, select the Hardware tab.

Click the Add + button to add an additional disk to the Node.

Size the disk based on the size of the resources you intend to transfer.

Click OK to accept the change.

Right-click the Node console icon and power on the Node.

Right-click the Node console icon and select Popout Console.

If you have not yet installed the VMware Remote Console plug-in, you are prompted to install it.

Using the console, log on to the Node as admin.

The default password is vmware.

At the command prompt, type:

```
ls /dev/sd*
```

A disk is created named something like "sdc".

Run the following command to add the new disk.

```
sudo /opt/vmware/hcagent/scripts/add_disk.sh <diskname>
```

Log out of the console.

Increase Maximum Concurrent Tasks

In vCloud Connector, you can start multiple tasks at the same time. By default, vCloud Connector executes a maximum of 10 concurrent tasks per vCloud Connector Node, that is, per cloud. If you specify more than 10 tasks, the first 10 tasks are executed concurrently. When a task finishes, the next one in the queue is executed.

You can increase the maximum number of concurrent tasks for a vCloud Connector Node.

If you increase the maximum number of concurrent tasks, you should also increase the storage allocated to the Node accordingly. The amount of extra storage you need depends upon the size of the resources you intend to transfer. About 50 GB is recommended for each added task.

As most tasks, such as a copy task, involve both a source cloud and a destination cloud, the maximum number applies to both. If you increase the maximum so that you can execute more than 10 copies at a time, for example, increase the storage for the Node in both the source and destination cloud.

Procedure

2. Log on as admin.

   The default password is vmware.

3. Click the Node tab, then click the General tab.

4. In the Concurrent Tasks Configuration section, type the maximum number of concurrent tasks, then click Change Maximum Concurrent Tasks.

5. Log out of the vCloud Connector Node Admin Web console.
What to do next

To enable advanced features available in vCloud Connector 2.0 Advanced edition (Content Sync and Datacenter Extension, also referred to as Stretch Deploy), you need to enter a valid vCloud Suite 5.1 license key.

**Prerequisites**
You have installed vCloud Connector. You have a valid vCloud Suite 5.1 license key.

**Procedure**
   You can get the IP address of the vCloud Connector Server from its console in the vSphere or vCloud Director cloud in which you installed it.
2. Log on as admin. If you have not changed the password, use vmware, the default password.
3. Click the Server tab, then click the General tab.
4. In the vCC License section, type the license key.
5. Click Update Key.

Advanced features in vCloud Connector are now enabled. You can access them in the vCloud Connector UI.
Upgrading to vCloud Connector 2.0

To upgrade to vCloud Connector 2.0 from version 1.5, follow the upgrade process described here.

NOTE After you upgrade vCloud Connector, clear your browser cache before you use the upgraded version. You need to do this to ensure new data is shown in the vCloud Connector Server or Node Admin Web consoles or in the UI.

This chapter includes the following topics:

- “Upgrade to vCloud Connector 2.0 from the Admin Web Consoles,” on page 55
- “Edit Hardware Settings for Upgraded vCloud Connector Server and Nodes on vSphere,” on page 56
- “Edit Hardware Settings for Upgraded vCloud Connector Server and Nodes on vCloud Director,” on page 57
- “Update Registration with vSphere Client,” on page 57

Upgrade to vCloud Connector 2.0 from the Admin Web Consoles

To upgrade to vCloud Connector 2.0, upgrade your vCloud Connector Server and all vCloud Connector Nodes.

You upgrade a vCloud Connector Server or Node from its Admin Web console.

Procedure

   You can get the IP address of the vCloud Connector Server or Node from its console in the vSphere cloud or vCloud Director cloud in which it is installed.

2. Log on to the Admin Web console as admin.
   The default password is vmware.

3. Click the Update tab, then click the Status tab.

4. Click Check Updates.
   The available updates appear.

5. Click Install Updates.

6. Accept the EULA.
Click **OK** in the confirmation dialog box.

Wait for the update process to finish. When it finishes, a “System reboot is required to complete the update” message appears.

Click the **System** tab.

Click **Reboot**.

You are logged out of the Admin Web console when the system finishes rebooting.

**What to do next**

Update the hardware settings for the upgraded vCloud Connector Server and Nodes. See

- “Edit Hardware Settings for Upgraded vCloud Connector Server and Nodes on vSphere,” on page 56
- “Edit Hardware Settings for Upgraded vCloud Connector Server and Nodes on vCloud Director,” on page 57

**Edit Hardware Settings for Upgraded vCloud Connector Server and Nodes on vSphere**

After you upgrade your vCloud Connector 1.5 Server and Nodes to vCloud Connector 2.0, update their virtual hardware settings to match those in vCloud Connector 2.0. The upgrade process does not change these settings.

Follow this procedure for the upgraded vCloud Connector Server and for all upgraded vCloud Connector Nodes that are installed on vSphere.

**Procedure**

1. Log on to the vSphere Client.
2. Select **Inventory > Hosts and Clusters**.
3. In the left pane, right-click your vCloud Connector Server or vCloud Connector Node virtual machine and select **Power > Power Off** to power it off.
4. Right-click your vCloud Connector Server or vCloud Connector Node and select **Edit Settings**.
5. In the **Hardware** tab, select **Memory** and increase the **Memory Size** to 3GB.
6. Click **OK**.
7. In the left pane, right-click your vCloud Connector Server or vCloud Connector Node virtual machine and select **Power > Power On** to power it on.

**What to do next**

Update the registration with the vSphere Client if your vCloud Connector 1.5 UI is registered as a plug-in in vSphere Client. See “Update Registration with vSphere Client,” on page 57.


Before you use the upgraded version of vCloud Connector, clear your browser cache.
Edit Hardware Settings for Upgraded vCloud Connector Server and Nodes on vCloud Director

After you upgrade your vCloud Connector 1.5 Server and Nodes to vCloud Connector 2.0, update their virtual hardware settings to match the settings in vCloud Connector 2.0. The upgrade process does not change these settings.

Follow this procedure for the upgraded vCloud Connector Server and all upgraded vCloud Connector Nodes that are installed on vCloud Director.

Procedure

1. Log on to the vCloud Director cloud.
2. Click My Cloud.
3. In the My Cloud panel, select VMs.
4. Select your vCloud Connector Server or vCloud Connector Node virtual machine and click the Power Off icon to power it off.
5. After it is powered off, right-click the vCloud Connector Server or Node virtual machine and select Properties.
6. Click the Hardware tab.
7. In the Memory section, increase the memory to 3GB.
8. Click OK.
9. Select your vCloud Connector Server or vCloud Connector Node virtual machine and click the Power On icon to power it on.

What to do next

Update the registration with the vSphere Client if your vCloud Connector 1.5 UI is registered as a plug-in in vSphere Client. See “Update Registration with vSphere Client,” on page 57.


Before you use the upgraded version of vCloud Connector, clear your browser cache.

Update Registration with vSphere Client

If your vCloud Connector 1.5 UI is registered as a plug-in in vSphere Client, after you upgrade vCloud Connector 1.5 to vCloud Connector 2.0, update its registration with the vSphere Client.

If you do not update the registration, vCloud Connector does not appear in the Solutions and Applications panel on the Home tab in vSphere Client.

Prerequisites

You have upgraded your vCloud Connector 1.5 Server and Nodes to version 2.0.

Procedure


You can get the IP address of the vCloud Connector Server from its console in the vSphere cloud or vCloud Director cloud in which it is installed.
2 Log on as **admin**.
   The default password is **vmware**.

3 Click the **Server** tab, then click the **vSphere Client** tab.

4 Specify the vCenter user name and password, then click **Update Registration**.

5 Log out of the Server Admin Web console.

**What to do next**


Before you use the upgraded version of vCloud Connector, clear your browser cache.
Cross-Cloud Data Transfer and Network Connectivity

vCloud Connector manages the transfer of content using a separate component, the vCloud Connector Node. Using Nodes allows multipart checkpoint-restart in transfers. This flow affects the way a request moves through the system and how network connectivity must be set up.

Data Flow in Transfer

The following graphic shows the path a vCloud Connector request takes in transferring data from a vSphere to a vCloud Director (VCD) cloud.

**NOTE** Port 443 is used when SSL is enabled and port 80 is used when SSL is disabled. By default, SSL is disabled for the vCloud Connector Server and enabled for vCloud Connector Nodes.

Enabling or disabling SSL on the vCloud Connector Server affects communication from the vCloud Connector UI to the Server. Enabling or disabling SSL on vCloud Connector Nodes affects communication from the Server to the Nodes and communication between Nodes.

**Figure 7-1. Cross-cloud Data Flow**

1. Customer requests transfer using vCloud Connector UI.
3. Node tells vCenter Server to "export" using VIM API.
4 Content is moved from datastores to source Node cache.
5 Content is transferred from source to destination Node using checkpoint-restart.
6 Destination Node calls the VCD API to “import”.
7 Content transfers from destination Node cache to VCD transfer server storage.
8 VCD sends the command for the appropriate vCenter import.
9 Content transfers from VCD transfer server storage to destination datastore network and is made available through the VCD catalog.
To uninstall vCloud Connector, delete the vCloud Connector Server and all the vCloud Connector Nodes associated with it. Before you delete the Server, you must unregister it from the vSphere Client to which it is registered. Before you delete a Node, you must unregister it from the Server to which it is registered.

This chapter includes the following topics:

- “Uninstall a vCloud Connector Server,” on page 61
- “Uninstall vCloud Connector Nodes,” on page 62

**Uninstall a vCloud Connector Server**

To uninstall vCloud Connector, unregister and delete the vCloud Connector Server and vCloud Connector Nodes.

**Procedure**

   You can get the IP address of the vCloud Connector Server from its console in the vSphere Client or vCloud Director cloud in which it is installed.
2. Log on as **admin**.
   If you did not change the password, use **vmware**, the default password.
3. Unregister the vCloud Connector Nodes that are registered with the vCloud Connector Server.
   a. Click the **Nodes** tab.
   b. Click the gears icon next to the first cloud and select **Unregister** from the pop-up menu.
   c. Click **OK** to confirm.
   d. Repeat for all the clouds that are registered with the Server.
4. Unregister the vCloud Connector Server from the vSphere client to which it is registered.
   a. Click the **Server** tab, then click the **vSphere Client** tab.
   b. Type the user name and password for the vSphere Client.
   c. Click **Unregister**.
Remove the Server from the vSphere or vCloud Director cloud in which it is installed.

To remove the Server from a vSphere Client

a Log on to the vSphere Client.

b In the Inventory pane, select VMs and Templates.

c Find your vCloud Connector Server virtual machine in the tree view.

d Right-click your vCloud Connector Server virtual machine and select Power > Power Off from the pop-up menu.

e When the vCloud Connector Server virtual machine is powered off, right-click on it again and select Delete from Disk from the pop-up menu.

To remove the Server from a vCloud Director cloud

a Log on to the vCloud Director cloud.

b Click the My Cloud tab.

c In the My Cloud panel, select vApps.

d Find your vCloud Connector Server vApp in the Name column, right-click it, and select Stop from the pop-up menu.

e When the Status column displays Stopped for the vCloud Connector Server vApp, right-click it again and select Delete from the pop-up menu.

f Click Yes to confirm.

The vCloud Connector Server is now deleted. You cannot access vCloud Connector from the vSphere Client.

Uninstall vCloud Connector Nodes

You can uninstall a vCloud Connector Node from a cloud if you no longer want to transfer content to and from that cloud. You must uninstall vCloud Connector Nodes when you uninstall vCloud Connector.

Procedure

1 Go to the vCloud Connector Server Admin Web console at https://vccServerIPaddress:5480.

   You can get the IP address of the vCloud Connector Server from its console in the vSphere Client or vCloud Director cloud in which it is installed.

2 Log on as admin.

   If you did not change the password, use vmware, the default password.

3 Click the Nodes tab.

4 Click the gears icon next to the vCloud Connector Node to delete, then select Unregister from the pop-up menu.

   The Node is now unregistered from the Server.

5 Repeat Step 4 for all the nodes you want to delete. If you are uninstalling vCloud Connector, delete all the nodes that are registered with the Server.

6 Log on to the cloud in which the vCloud Connector Node is installed.
7 If the vCloud Connector Node is installed on a vSphere cloud, delete it from the cloud.
   a In the **Inventory** pane, select **VMs and Templates**.
   b In the tree view, right-click the vCloud Connector Node virtual machine and select **Power > Power Off** from the pop-up menu.
   c When the vCloud Connector Node virtual machine is powered off, right-click it again and select **Delete from Disk** from the pop-up menu.

8 If the vCloud Connector Node is installed on a vCloud Director cloud, delete it from the cloud.
   a Click the **My Cloud** tab.
   b In the My Cloud panel, select **vApps**.
   c Find your vCloud Connector Node vApp in the Name column, right-click it, and select **Stop** from the pop-up menu.
   d When the Status column shows Stopped for the vCloud Connector Node vApp, right-click it again and select **Delete** from the pop-up menu.
   e Click **Yes** to confirm.

The vCloud Connector Node is deleted from the cloud. The cloud does not appear in the list of clouds in the vCloud Connector UI.
Troubleshooting vCloud Connector

Use this information to troubleshoot problems with your vCloud Connector installation.

- **Troubleshooting Storage** on page 65
  If a transfer is interrupted in the middle, for example because of a network outage, temporary storage in the Node might not be cleaned up, leading to a loss of usable storage space, even if the transfer completes normally.

- **Troubleshooting Connectivity** on page 66
  You can use cURL to pinpoint connectivity problems among the components of your vCloud Connector installation.

- **Accessing Log Files from the UI** on page 66
  You can access log files for a vCloud Connector Server or vCloud Connector Node instance from its Admin Web console.

- **Accessing Log Files from the Console** on page 67
  You can access log files for a vCloud Connector Server or vCloud Connector Node instance through its console.

- **Accessing Log Files for a Multi-tenant Node** on page 68
  If you are using a vCloud Connector Node that has been deployed as a multi-tenant node by a public vCloud Service Provider or private vCloud Director system administrator, you do not have access to the vCloud Connector Node console or Web console. You can download Node log files for your own organization from your vCloud Connector Server Admin Web console.

- **Troubleshooting Log File Size** on page 68
  To modify the size of log files or the number of files that are retained, you must modify the vCloud Connector Server or Node configuration files.

### Troubleshooting Storage

If a transfer is interrupted in the middle, for example because of a network outage, temporary storage in the Node might not be cleaned up, leading to a loss of usable storage space, even if the transfer completes normally.

If you notice that the available storage space in a Node has decreased after a transfer during which an interruption occurred, reboot the Node. The temporary files are deleted on reboot.
Troubleshooting Connectivity

You can use cURL to pinpoint connectivity problems among the components of your vCloud Connector installation.

Log on to the appropriate instance as **admin** either through the console or via SSH. The default password is **vmware**. The following procedure tests all the connections in order. Use whichever segments are useful to you. Use the `-x`, `--proxy <[protocol://]proxyhost>` option if necessary.

**Prerequisites**

You have installed your vCloud Connector Server and Nodes and they are running. You have any necessary proxy information.

**Procedure**

1. Log on to the vCC Server to test the vCC Server connections.
2. Test the connection between the vCC Server and a vCloud Director cloud:
   
   ```
curl -k -v https://vcd-host/api/versions
   ```
3. Test the connection between the vCC Server and a vCenter Server:
   
   ```
curl -k -v https://vc-host/mob
   ```
4. Test the connection between the vCC Server and a vCC Node:
   
   ```
curl -k -v https://node-host/agent/api/v2/org/org/version
   ```
5. Log on to the vCC Node located in the vSphere internal cloud to test the vCC Node connections used in the copy path.
6. Test the connection between the vCC Node and the vCenter Server:
   
   ```
curl -k -v https://vc-host/mob
   ```
7. Test the connection between the vCC Node and the ESX host:
   
   ```
curl -k -v https://esx-host/mob
   ```
8. Test the connection between the vSphere vCC Node and a vCloud Director vCC Node outside the firewall:
   
   ```
curl -k -v https://node-host/agent/api/v2/org/org/version
   ```
9. Log on to the vCloud Director vCC Node.
10. Test the connection between the vCloud Director vCC Node and the vCloud Director cloud:
    
    ```
curl -k -v https://vcd-host/api/versions
    ```

Accessing Log Files from the UI

You can access log files for a vCloud Connector Server or vCloud Connector Node instance from its Admin Web console.

**Note** If you are using a public cloud, you can only access your own log files, not those of other organizations in the cloud.

**Note** If you are using a multi-tenant vCloud Connector Node deployed by a public vCloud Service Provider or private vCloud Director system administrator, you do not have access to the Node Admin Web console. See “Accessing Log Files for a Multi-tenant Node,” on page 68.
Procedure

2. Log on as admin.
   The default password is vmware.
3. Download the log files.
   - In the Server Admin Web console, click the Server tab, then click the General tab and click Download logs.
   - In the Node Admin Web console, click the Node tab, then click the General tab and click Download logs.
4. Save the zip file.
5. Extract files from the zip file.
   The Node log file is named hca.log and is in the opt/vmware/hcagent/logs directory. The Server log file is named hcs.log and is in the opt/vmware/hcserver/logs directory.
   Older log files are in a zip file in the same directory.
   Tomcat log files are named catalina.<Date>.log.

Accessing Log Files from the Console

You can access log files for a vCloud Connector Server or vCloud Connector Node instance through its console.

Server log files are in the /opt/vmware/hcserver/logs directory. Node log files are in the /opt/vmware/hcagent/logs directory.
Node log files are divided by organization.

**Note** If you are using a public cloud, you can only access your own log files, not those of other organizations in the cloud.

**Note** If you are using a multi-tenant vCloud Connector Node deployed by a public vCloud Service Provider or private vCloud Director system administrator, you do not have access to the Node console. See “Accessing Log Files for a Multi-tenant Node,” on page 68.

Procedure

1. In your vSphere Client or vCloud Director cloud, open the Server or Node instance console and log on as admin.
   The default password is vmware.
2. Go to the hcserv or hcagent directory.
   - cd /opt/vmware/hcserver/logs
   - cd /opt/vmware/hcagent/logs
   Older log files are in a zip file in the same directory.
   For vCloud Connector Node, organization-specific log files are in /opt/vmware/hcagent/logs/<Organization>/.
   Tomcat log files are named catalina.<Date>.log.
Accessing Log Files for a Multi-tenant Node

If you are using a vCloud Connector Node that has been deployed as a multi-tenant node by a public vCloud Service Provider or private vCloud Director system administrator, you do not have access to the vCloud Connector Node console or Web console. You can download Node log files for your own organization from your vCloud Connector Server Admin Web console.

Procedure

2. Log on as admin.
   The default password is vmware.
3. Click the Nodes tab.
4. Click the gears icon next to the multi-tenant Node that you registered with your Server, and select Download Logs.
5. Save the zip file.
6. Extract files from the zip file.
   The Node log file is named hca.log and is in the opt/vmware/hcagent/logs directory.

Troubleshooting Log File Size

To modify the size of log files or the number of files that are retained, you must modify the vCloud Connector Server or Node configuration files.

Prerequisites

The original configuration file is backed up.

Procedure

1. Open the running instance console and log on as admin.
   The default password is vmware.
4. Adjust the appropriate values in the following XML snippets:
   <rollingPolicy class="ch.qos.logback.core.rolling.FixedWindowRollingPolicy">
     <fileNamePattern>/opt/vmware/hcserver or hcagent/logs/hcs.%i.log.zip or hca.%i.log.zip</fileNamePattern>
     <minIndex>1</minIndex>
     <maxIndex>9</maxIndex>
   </rollingPolicy>

   <triggeringPolicy class="ch.qos.logback.core.rolling.SizeBasedTriggeringPolicy">
     <maxFileSize>10MB</maxFileSize>
   </triggeringPolicy>

   To modify the number of files to retain, change rollingPolicy/maxIndex to the desired number.
To modify the size of log files, change `triggeringPolicy/maxFileSize` to the desired size.

**Note** This is the size of a single file, so the total log size could be as large as this value times the `maxNumber` value. Archived log files are zipped, however, so the total log size is usually much smaller.

5 Save the file. You do not need to restart.
Index

A
add node to catalog 32, 35
advanced features 7

B
browsers 18

C
certificates 29, 41, 45, 48, 49
collect information 16
concurrent tasks 41, 51
configure node 39
configure server 27
create node, vCloud Director 1.5 32
create node, vCloud Director 5.1 36
create server, vCloud Director 1.5 21
create server, vCloud Director 5.1 24

D
data transfer flow 59
download 19

E
editions 7, 53

F
firewall 22, 26, 33, 37

H
hardware settings, upgrade 56, 57

I
install node, vCloud Director 1.5 31
install node, vCloud Director 5.1 34
install node, vSphere 30
install nodes 30
install Server 20
install Server, vCloud Director 1.5 20
install Server, vCloud Director 5.1 23
install Server, vSphere 20

L
license key 29, 53
log files
access 66
size 68
log files, access 67

M
maximum concurrent tasks 41, 51
multiple intermediate SSL certificates 48

N
NAT 22, 26, 33, 37
network settings 28, 39
Network tab, node 39
Network tab, server 28
node storage 50
node storage, vCloud Director 50
node storage, vSphere 50
Node tab 41
nodes 9
Nodes tab 30

O
overview 5, 9, 15

P
password 29, 41
planning installation 11
ports 18
production 45
proxy settings 28, 39

R
reboot, node 39
reboot, server 27
register nodes with clouds 38
register nodes with server 42
register UI 43
register UI, vSphere Client 44
requirements 18

S
server 9
Server tab 29
service provider deployment 11
SSL certificates 29, 41, 45, 48, 49
System tab, node 39
System tab, server 27

T
time zone settings 27, 39
troubleshooting, log 68
troubleshooting, connectivity 66
troubleshooting, log 66
troubleshooting, log file size 68
troubleshooting, overview 65
troubleshooting, storage 65
trusted keystore 49

U
UI 9, 43, 44
uninstall 61
uninstall, nodes 62
uninstall, server 61
update policy 28, 40
update registration, upgrade 57
Update tab, node 40
Update tab, server 28
upgrade
   hardware settings 56
   update registration 57
upgrade, hardware settings, hardware settings 57
upload node to catalog 32, 35
upload server to catalog 21, 24

V
vCloud Connector Advanced 7, 53
vCloud Connector Core 7